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Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
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Documentation Feedback
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Welcome to Smart View Installation and

Configuration

ORACLE

This help includes topics on these subjects:

To find information in this help, click Contents or Search in the left frame.

Installing Oracle Smart View for Office
Administering extensions

Configuring shared connections in an XML file
Configuring locally-installed help
Troubleshooting tips

Limitations

1-1



Installing Smart View

Related Topics

*  About Installing Smart View

* Installation Guidelines

» Installing from My Oracle Support or Oracle Technical Resources
* Installing Browser Add-ons

* Installing by Autodeployment in EPM System

* Installing from EPM Workspace

* Installing from Oracle Bl EE

*  Running Command Line or Silent Installations

»  Exporting Default Smart View Options

» Downloading Help for Local or Web Server Installation

e Uninstalling Smart View

About Installing Smart View

Oracle Smart View for Office uses a single installer for 64-bit and 32-bit versions of Microsoft
Office, starting with release 11.1.2.5.

Late-breaking information about the Smart View installation is provided in the Oracle Smart
View for Office Readme. You should thoroughly review this chapter along with the information
in the readme before installing Smart View.

Late-breaking information about installing client products in Oracle Enterprise Performance
Management Cloud environments is provided in the What's New document for each service.
Review this information thoroughly before installing client products.

Late-breaking information about the installation of Oracle Enterprise Performance
Management System products is provided in the Oracle Enterprise Performance
Management System Installation and Configuration Readme. Review this information
thoroughly before installing EPM System products.

Installation Guidelines

ORACLE

Related Topics

* Installation and Windows Access Control Settings

» Installer Language

e Microsoft .NET Framework Support

* Internet Explorer 11 End of Support and Smart View
*  Microsoft Edge WebView2 Support
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» BIiDi Support in Installer
* Upgrading from Smart View 11.1.1.3.x or Earlier
* Oracle Bl EE Extension Users: Upgrading from Smart View 11.1.2.5.500 or Earlier

» Oracle Bl EE Version Requirement for Multiple Connection and View Designer
Features

*  Planning Offline Support

Installation and Windows Access Control Settings

Starting with the 11.1.2.5.400 release, you can install Oracle Smart View for Office as
a System user or as a hon-admin user.

Windows User Access Control (UAC) settings can affect Smart View installation. For
information on setting UAC, see the Microsoft Windows documentation.

Also, see Tips and Troubleshooting if you encounter issues related to installation.

Table 2-1 Installation Guidelines for System, Admin, and Non-Admin Users

Installation Context Scenario UAC-Enabled Result

System user SmartView.exe is Not applicable Smart View is installed on
launched by the Windows the machine level
scheduler or PsExec

Administrator The user runs Depending on the UAC Smart View is installed on
SmartView.exe with the level, the user may need to the machine level
"Run as Administrator" go through the UAC UI
command or from an sequence
elevated command prompt

Non-admin user The user installing Smart  No UAC interaction is Smart View is installed on
View may or may notbe a  expected. the current user's level,
member of the other users will not be able
Administrators group. to run Smart View

Note: Not supported on
Windows server platforms.

Notes:

*  This scenario is not supported: A user installs Smart View, and then, on the same
machine, another user tries to install Smart View in the same location as the
previous installation.

e After non-admin installations:
— The Smart View ribbon may fail to appear on Windows 10.

See Smart View Ribbon Fails to Display After Non-Admin Installation for steps
to take to display the ribbon.

— Launching Office applications with Smart View content from Internet Explorer
will fail in protected mode.
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< Note:

Starting with Oracle Enterprise Performance Management System Release
11.2.2 and the Oracle Enterprise Performance Management Cloud 20.09
update, Internet Explorer is no longer supported. This guideline is kept here
for the purpose of backward compatibility. For more information, see
Internet Explorer 11 End of Support and Smart View.

* Upgrade in mixed installation context is not supported. For example, upgrading the
previously-installed per-machine installation with a per-user one is not supported (Error
1925).

» Silent installations are not supported for non-admin users. When attempting a silent
installation, the /s flag is ignored for non-admin users, causing the Smart View product
installer to launch.

* Non-admin users are not authorized to install Smart View in the C:\Program Files or
C:\Program Files (x86) folders.

Installer Language

The installer is automatically displayed in the language set in the Format field of the Windows
Region and Language dialog box in the Control Panel.

However, some messages, both on-screen and in the log file, cannot be translated and will
appear in English.

For more information about language settings, see Windows, Office, and Smart View Locale
Settings.

Microsoft .NET Framework Support

Oracle Smart View for Office requires a supported version of Microsoft .NET Framework.
Oracle recommends using .NET Framework 4.8 or higher.

Note that Microsoft .NET Framework 4.5.2, 4.6, and 4.6.1 are no longer supported after April
26, 2022. For more information, see .NET Framework 4.5.2, 4.6, 4.6.1 will reach End of
Support on April 26, 2022.

Internet Explorer 11 End of Support and Smart View

Microsoft has announced end of support of Internet Explorer 11 by June 15, 2022.

Do not uninstall Microsoft Internet Explorer, even after the end-of support date of June 15,
2022. Instead, you may securely disable Internet Explorer following Microsoft's guidelines. In
situations where the Internet Explorer browser would be called, the Edge browser will be
launched instead.

Oracle Smart View for Office does not require the Internet Explorer browser specifically.
However, Smart View depends on Winlnet APIs that may have dependencies on Internet
Explorer. Microsoft recommends keeping Internet Explorer installed on the machine since
uninstalling may cause other applications that are dependent on it to work incorrectly.
Microsoft also recommends updating to the latest security patches as they become available.

ORACLE 2-3


https://devblogs.microsoft.com/dotnet/net-framework-4-5-2-4-6-4-6-1-will-reach-end-of-support-on-april-26-2022/
https://devblogs.microsoft.com/dotnet/net-framework-4-5-2-4-6-4-6-1-will-reach-end-of-support-on-april-26-2022/

Chapter 2
Installation Guidelines

For more information, see Oracle Support Document 2877741.1, Impact on Smart
View with Microsoft decommissioning Internet Explorer 11 on June 15, 2022 (Doc ID
2877741.1).

Microsoft Edge WebView2 Support

Oracle Smart View for Office uses the Microsoft Internet Explorer module to display
the authentication page. But certain authentication schemes may require newer
controls, such as WebView2, to process a complex login sequence. To use WebView2,
Microsoft Edge WebView2 Runtime should be installed and enabled on each Smart
View client machine.

Starting with the 21.100 release, Smart View supports WebView2. During runtime,
Smart View detects the presence of Microsoft Edge WebView2 Runtime installed on
the machine and launches the WebView2-based dialog to host the login page.

Once WebView? is installed on Smart View client machines, users can enable it in the
Smart View Options section of Health Check (described in Performing a Health
Check On Your System in the Oracle Smart View for Office User's Guide). WebView2
can also be enabled by editing the Smart View properties.xnl file (by default in
C:\Oracle\SmartView\cfg).

Administrators: If WebView?2 is required to handle the login sequence used by your
organization, then you should ensure that Microsoft Edge WebView2 Runtime is
installed and enabled on the machines running Smart View. If you are installing
Microsoft Edge WebView2 Runtime, Oracle recommends using the Evergreen version.
Only WebView?2 versions 86.0.616.0 and later are supported.

Once installed, Microsoft distributes WebView2 updates on a regular cadence, unless
a fixed version was installed. Administrators can use their own internal procedures to
download and distribute Microsoft Edge WebView2 Runtime to Smart View users. The
download is here:

https://docs.microsoft.com/en-us/deployoffice/webview2-install#webview2-runtime-
installation

For more information, see the WebView2 documentation.

BiDi Support in Installer
The Oracle Smart View for Office installer does not fully support bidirectional (BiDi)
languages. This can result in installer screens containing formatting errors such as

misaligned text and icons. The installer can be used, however, and the installed Smart
View product will display correctly in BiDi languages.

Upgrading from Smart View 11.1.1.3.x or Earlier

When upgrading from Oracle Smart View for Office release 11.1.1.3.x or earlier, Oracle
recommends uninstalling Smart View before installing this release.

ORACLE 2.4
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Oracle Bl EE Extension Users: Upgrading from Smart View 11.1.2.5.500 or
Earlier

If you're using the Oracle Bl EE extension, and upgrading from Oracle Smart View for Office
11.1.2.5.500 or earlier to Smart View 11.1.2.5.510 or later, a complete uninstall of Smart View
is required:

1. Close all Office applications.

2. Uninstall Smart View from the Windows Control Panel.

3. Install Smart View.

See Installing from My Oracle Support or Oracle Technical Resources.

Oracle Bl EE Version Requirement for Multiple Connection and View
Designer Features

To use the multiple connection and View Designer features described below, ensure that the
Oracle Business Intelligence Enterprise Edition 11.1.1.7.140527 patch or higher is installed.
Go to My Oracle Support, Patches & Updates tab, and search by "Product or Family." In the
Product field, select Oracle Business Intelligence Enterprise Edition; in the Release field,
select OBI EE 11.1.1.7.140527.

e Multiple connections are supported with Oracle Bl EE version 11.1.1.7.140527 and
higher. If connecting to earlier versions of Oracle Bl EE, then only one connection is
allowed.

e To use the Oracle Bl EE View Designer feature (introduced in the 11.1.2.5.200 release),
the Oracle Bl EE 11.1.1.7.140527 patch or higher is required.

You should only use the View Designer in Oracle Smart View for Office to edit views that
were created and inserted using the View Designer.

See "Editing Views Created in View Designer" in the Oracle Smart View for Office User's
Guide for more information.

Planning Offline Support

Although Planning Offline is supported for 64-bit operating systems, it is not supported for 64-
bit Oracle Smart View for Office installations. If you use Planning Offline with Smart View, you
must install the 32-bit version of Microsoft Office.

< Note:

Planning Offline is supported with Oracle Hyperion Planning on-premises only.
Planning Offline is not supported with the Planning business process in Oracle
Enterprise Performance Management Cloud.
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Installing from My Oracle Support or Oracle Technical
Resources

To install Oracle Smart View for Office directly from My Oracle Support (MOS) or
Oracle Technology Resources (OTR; formerly Oracle Technology Network, OTN):

ORACLE

1. Before you begin:

If you are upgrading to this release from an earlier Smart View release, Oracle
recommends that you first uninstall the earlier release before installing this
release.

If you installed using the Smart View installer wizard, see Uninstalling Smart
View.

If you installed using the command line or silent install, see Running
Command Line or Silent Installations.

Ensure that a supported version of Microsoft .NET Framework is installed on
the computer where you are installing Smart View. See Microsoft .NET
Framework Support for .NET requirements.

A supported version of Microsoft .NET Framework is required to install and
use Smart View.

Review the information in Installation Guidelines.

2. Close all Microsoft Office applications, including Outlook.

" Note:

Oracle recommends ensuring that all Microsoft Office processes are
terminated on the machine where you plan to install Smart View. In
Windows Task Manager, check for and terminate these Office processes:
Excel, Word, PowerPoint, and Outlook.

3. Download the Smart View zip file from either MOS or OTR:

From MOS:

https://support.oracle.com/oip/faces/secure/km/DocumentDisplay.jspx?
id=1923582.1

This Knowledge Article provides a link to the current version of Smart View.
From OTR:

https://www.oracle.com/middleware/technologies/epm-smart-view-
downloads.html

Before downloading, review the "Oracle License Agreement" accessed from
the Smart View download page to ensure that your usage is compliant.

4. Unzip the file to a temporary location.

5. To start the installation wizard, right-click smartview.exe and select Run as
administrator.
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You may also double-click smartView.exe to start the installation wizard; however, some
configurations may require Run as administrator. Therefore, Oracle recommends using
the Run as administrator command to ensure that all functionality is properly enabled
and all required Windows Registry entries are set. See Installation and Windows Access
Control Settings for more information.

6. Select a destination folder for Smart View, and then click OK.

For new installations, Smart View is installed by default in:

C:\Oracle\SmartView

If you are upgrading an existing installation of Smart View, the installer defaults to the
folder where Smart View was previously installed.

# Note:

Oracle recommends installing in the default location or in a location that does
not contain any spaces in the installation path. For example, Oracle advises
that you do not install in C:\Program Files Or C:\Program Files (x86).

7. When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint,
or Word.

" Note:

Starting with Smart View 11.1.2.5.510, the Oracle Bl EE per-user extension
installer is included with the Smart View client installation. If the extension is not
already installed and it is not disabled, then it is installed the first time you start
Office.

8. If you plan to use drill-through reports or web launch, a browser add-on is required for all
supported browsers (Microsoft Edge, Mozilla Firefox, and Google Chrome). See Installing
Browser Add-ons for more information.

# Note:

If you encounter issues related to installation and startup, see Tips and
Troubleshooting.

Installing Browser Add-ons

You can use Oracle Smart View for Office to interact with web browser applications, such as
Financial Consolidation and Close or Oracle Hyperion Planning, in two ways:

e Starting in a form or ad hoc grid in Smart View, use drill-through to launch an application
web page in a browser

ORACLE .
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Installing Browser Add-ons

e Starting in a web application, launch a form or ad hoc grid in Smart View for Excel.

Mozilla Firefox, Google Chrome, or Microsoft Edge require a Smart View add-on for

drill-through and web launch.

Table 1 summarizes the browser add-on requirements.

Table 2-2 Browser Add-on Requirements for Drill-Through and Web Launch

Browser

Add-on Required?

Mozilla Firefox

Google Chrome

Microsoft Edge

Yes

Yes

Yes

4

4

Note:

Requires
installing
Chrome
extension
version 22.200
by December
31, 2022.

Note:

Requires
installing
Chrome
extension
version 22.200
by December
31, 2022.
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Table 2-2 (Cont.) Browser Add-on Requirements for Drill-Through and Web
Launch

_______________________________________________________________________|
Browser Add-on Required?

Microsoft Internet Explorer Not supported

# Note:

Starting with
Oracle
Enterprise
Performance
Management
System Release
11.2.2 and the
Oracle
Enterprise
Performance
Management
Cloud 20.09
update,
Internet
Explorer is no
longer
supported. For
more
information,
see Internet
Explorer 11 End
of Support and
Smart View.

For instructions on obtaining and installing the add-on for Firefox, Chrome, and Edge, see:
*  Mozilla Firefox

* Google Chrome

* Microsoft Edge

The following subtopics provide the default instructions for installing the browser add-ons and
assume access to web app stores. If your users require a method for installing the add-ons
without directly accessing a web app store, see Alternative Methods for Installing Browser
Add-ons to explore other methods for installing the add-ons for Chrome and Edge.

Mozilla Firefox

To use Smart View 11.1.2.5.810+ with Mozilla Firefox ESR 60+, you must install the Oracle
Smart View for Office web extension for Firefox.

You can get the extension by searching on "smartview" on the Firefox Add-ons download site
or by going directly to this link:

https://addons.mozilla.org/en-US/firefox/addon/oracle-smart-view-for-office
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Click the + Add to Firefox button and follow the prompts to add the extension.

# Note:

If you are using earlier versions of Firefox, then no add-on is required.

Google Chrome

EPM Cloud 17.06+ supports interoperability with Google Chrome and Smart View
11.1.2.5.700+.

To use Google Chrome with Smart View, install the Oracle Smart View for Office web
extension from the Chrome Web Store. You can get the extension by searching on
"smartview" in the Chrome Web Store or by going directly to this link:

https://chrome.google.com/webstore/detail/oracle-smart-view-for-off/
cjbpfomjjhkmfkembnjejkhpihjnomne

Click the Add to Chrome button and follow the prompts to add the extension.

Microsoft Edge

EPM Cloud 20.04+, EPM System 11.2.1+, and EPM System 11.1.2.4.825+ support
interoperability with Microsoft Edge based on Chromium 80+ and Smart View
11.1.2.5.910+.

To use Microsoft Edge with Smart View, you must enable Edge to allow extensions
from other stores, and then install the Oracle Smart View for Office web extension from
the Chrome Web Store.

To enable Edge to allow extensions from other stores, and then install the Chrome
extension:

1. Install the latest version of Edge from Microsoft.

2. In the upper right corner of Edge, click Settings and more, ---, and then select
Extensions.

3. In the popup window, click the Manage extensions link.
4. On the Extensions page, click the Chrome Web Store link.

5. At the top of the page, click Allow extensions from other stores, and in the
confirmation dialog, click Allow.

6. Use this link to access the Oracle Smart View for Office web extension:

https://chrome.google.com/webstore/detail/oracle-smart-view-for-off/
cjbpfomjjhkmfkembnjejkhpihjnomne

Or, you can get the extension by searching on "smartview" in the Chrome Web
Store.

7. Click the Add to Chrome button and follow the prompts to add the extension.

Alternative Methods for Installing Browser Add-ons

In some organizations, users are not allowed direct access to the Chrome Web Store
where they can download the add-on, or extension file, for Google Chrome or
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Microsoft Edge. If this is the case in your organization, you can refer to the information in the
following Chrome help topic to facilitate installing the add-on for your users:

Alternative extension distribution options

In particular, Oracle recommends the following two methods to facilitate installing the add-on
for your users.

* Installing the Smart View Chrome Extension Using the Windows Registry

* Installing the Chrome Extension for Smart View Using the Downloaded CRX File

¢ Note:

Both methods can be used with Google Chrome or Microsoft Edge.

Installing the Smart View Chrome Extension Using the Windows Registry

General instructions for installing extensions using the Windows Registry are found in the
Chrome help topic, Using the Windows registry.

Information specific to Oracle Smart View for Office is noted in the following procedures.
To install the add-on using the the Windows Registry:
1. Open the Windows Registry Editor.
2. Locate the following key in the registry; create this key if it is not present.
Chrome:
e 32-bit Windows:
HKEY LOCAL MACHINE\Software\Google\Chrome\Extensions
*  64-bit Windows:
HKEY LOCAL MACHINE\Software\Wow6432Node\Google\Chrome\Extensions
Edge:
e 32-bit Windows:
HKEY LOCAL MACHINE\Software\Microsoft\Edge\Extensions
*  64-bit Windows:
HKEY LOCAL MACHINE\Software\Wow6432Node\Microsoft\Edge\Extensions

3. Under the Extensions key, create a new key (folder) with this name:

cjbpfomjjhkmfkembnjejkhpihjnomne

The letter combination noted above is specific to the Oracle Smart View for Office
extension for Chrome and Edge.

4. In the extension key, create this property:

update url
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Then set the value of the new property to this URL:

https://clients2.google.com/service/update2/crx

This URL points to the extension's CRX file in the Chrome Web Store.

Verify that the extension is installed.

Chrome

Launch the Chrome browser and, in the address bar, enter:

chrome://extensions

The Oracle Smart View for Office extension is listed in the Extensions page.
Edge

Launch the Edge browser, select the Settings and more icon, -++, and then
select Extensions.

The Oracle Smart View for Office extension is listed in the Extensions page
under Installed extensions.

Installing the Chrome Extension for Smart View Using the Downloaded CRX File

In this procedure, you work with the downloaded Chrome extension CRX file for Smart

View.

1. Download the Smart View extension CRX file from the following location to a
temporary location on your computer (such as the Downloads folder):

Link to Smart View Chrome Extension CRX File

" Note:

Typically, this step is performed by someone with access to the Chrome
Web Store.

The following steps can be automated by an administrator or can be
performed by users if they have access to the CRX file and can enable
Developer mode on their Chrome or Edge browser.

2. Perform the procedure for Chrome or Edge, as you require:

Chrome:

a.

Launch the Chrome browser, click the Chrome menu icon, - , then select
More tools, and then select Extensions.

Ensure that the Developer mode check box in the upper right corner is
enabled.

Use drag-and-drop to drag the CRX file from the temporary location you used
in step 1, and drop it into the Extensions window to install.
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d. To verify the install, relaunch the Chrome browser and, in the address bar, enter:

chrome://extensions

The Oracle Smart View for Office extension is listed in the Extensions page.
Edge:

a. Launch the Edge browser, click the Settings and more menu icon, --+, and then
select Extensions.

b. Ensure that the Developer mode check box in the lower left corner is enabled.

c. Use drag-and-drop to drag the CRX file from the temporary location you used in step
1, and drop it into the Extensions window to install.

d. To verify the install, relaunch the Edge browser and, in the address bar, enter:

edge://extensions

The Oracle Smart View for Office extension is listed in the Extensions page.

3. Optional: In your Chrome or Edge browser, disable the Developer mode check box, per
your organization's requirements.

Installing by Autodeployment in EPM System

These instructions are for upgrading from Oracle Smart View for Office 11.1.2.1.x and later
only. If you are upgrading from Smart View 11.1.2.0.x or earlier, use the autodeployment
instructions provided in the documentation for the specific release.

See:

e Server Setup

e Client Installation

Server Setup

To set up the server environment for autodeployment of Oracle Smart View for Office:

1. Enable autodeployment for your data provider as follows.
* Oracle Essbhase: Choose a method:
— Use Administration Services Console (if available).

a. Connect to the Provider Server, select Edit, then Properties, then Client
Deployment.

b. Choose either Force Smart View client to upgrade or Warn Smart View
client to upgrade.

c. Select the Apply Smart View client to upgrade check box, and then click
Apply.
— Update essbase.properties as follows:

a. Navigate to EPM_ORACLE INSTANCE\bin\essbase.properties.
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b. Set either or both of these properties to true:

smartview.webservice.autodeploy.force=true
smartview.webservice.autodeploy.warn=true
e Oracle Hyperion Planning:

a. Select Administration, then Manage Properties, and then System
Properties.

b. Set these properties:

SMART VIEW FORCE INSTALL=true
SMART VIEW DISPLAY WARNING=true

»  Oracle Hyperion Financial Management: Autodeployment is enabled by
default starting in Financial Management 11.1.2.4. To configure Financial
Management to turn off messages about upgrading Smart View, complete the
procedure in Oracle Support Document 1993603.1 on My Oracle Support:

https://support.oracle.com/knowledge/
Enterprise%20Performance%20Management%20and%20Business%20Intellig
ence/1993603_1.html

» Oracle Hyperion Reporting and Analysis: Autodeployment is automatic.

Make backup copies of your current SmartView.exe and version.xml before
deploying the replacement files.

Download the Smart View zip file from either Oracle Technical Resources (OTR)
or My Oracle Support (MOS), as described in Installing from My Oracle Support or
Oracle Technical Resources.

Unzip the downloaded file to a temporary location.

Copy SmartView.exe and version.xml to the location of the Oracle Hyperion
Enterprise Performance Management Workspace installation, typically:

C:\Oracle\Middleware\EPMSysteml1R1\common\epmstatic\wspace\SmartView

This is the epmstatic location specific to Smart View.

Depending on which version of Smart View your users are upgrading from,
perform either Option A OR Option B.

* Option A (Upgrading from 11.1.2.1.x, 11.1.2.2.x, or 11.1.2.3.X)

If your users are upgrading from an installed Smart View version of 11.1.2.1.x,
11.1.2.2.x, or 11.1.2.3.x, open the version.xml file in the epmstatic location
specific to Smart View (see step 5), and edit the value in the installFile tag
to point to the location of the Smart View executable file (step 5) as follows:

<installFile>
/epmstatic/wspace/SmartView/SmartView.exe

</installFile>

* Option B (Upgrading from 11.1.2.5.000 or Later)
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Client Installation

In the previous section, Server Setup, if you chose the OTR Option in Option B, then your
users will be directed to Oracle Technical Resources (OTR) for the Oracle Smart View for
Office download. In that case, your users should follow the instructions for OTR download
and installation in Installing from My Oracle Support or Oracle Technical Resources.
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If your users are upgrading from an installed Smart View version 11.1.2.5.000_or
later, choose only one of the following options and perform the tasks described:

OTR Option

Do not modify the version.xml file in the epmstatic location specific to Smart
View (step 5).

Your users will automatically be directed to the Smart View page on OTR, where
they can download the installation zip file to their own machines, unzip the
contents, and run the installer.

"epmstatic” Option

Open the version.xml file in the epmstatic location specific to Smart View (see
step 5) and edit the value in the installFile tag to point to the location of the
Smart View executable file (step 5) as follows:

<installFile>
/epmstatic/wspace/SmartView/SmartView.exe
</installFile>

Web App Server Option

Post the SmartView.exe file to a web app server in your environment, and then
modify the version.xml file to point to the fully-qualified URL.

a. Copy only the Smartview.exe to the web app server where you will be
hosting the file.

b. Open the version.xml file in the epmstatic location specific to Smart View
(see step 5), and edit the value in the installFile tag to point to the fully-
qualified URL where you are hosting the Smart View executable file (see
step a); for example:

<installFile>
http://webServerHost:webServerPort/pathToSmartViewExe/

SmartView.exe

</installFile>

Your Smart View users can now proceed with Client Installation.

If you did not choose the epmstatic Option or Web App Server Option in Option B, then
complete the following procedure.

To install the Smart View client:

In Smart View, select Panel.

Connect to a data source in one of the following ways:

Through a shared connection
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* Through a private connection with the following URL:
— Oracle Essbase: http://<server>:19000/aps/SmartView

— Oracle Hyperion Planning: http://<server>:19000/HyperionPlanning/
SmartView

— Oracle Hyperion Financial Management: http://<server>:19000/
hfmofficeprovider/hfmofficeprovider.aspx

— Oracle Hyperion Reporting and Analysis: http://<server>:19000/
raframework/browse/listxml

< Note:

If you are using Reporting and Analysis release 11.1.2.1.000 or
earlier, Smart View autodeployment will not work (10233672,
12870087).

When the message "New Smart View client version available" is displayed, select
Click here to Install.

In the browser that launches, in File Download, select Run.

If a Microsoft Excel security warning is displayed, select Run.
When prompted, confirm the upgrade; click Yes.
The installation wizard is displayed; click OK.

The installer is automatically displayed in the language set in the Format field of
the Windows Region and Language dialog box in the Control Panel.

If prompted, close all open Microsoft Office applications, and then click OK.

In the installation wizard, click OK and follow the prompts to install Smart View.

# Note:

Oracle recommends installing in the default location or in a location that
does not contain any spaces in the installation path. For example, Oracle
advises that you do not install in C:\Program Files or C:\Program

Files (x86).

When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.

Open Excel.
On the Smart View ribbon, select the arrow next to Help, and then select About.

Verify the new version of Smart View.
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Installing from EPM Workspace

ORACLE

To install Oracle Smart View for Office from Oracle Hyperion Enterprise Performance
Management Workspace:

Before you begin:

* The Smart View installer is located on Oracle Technology Resources (OTR). You
must be able to access the internet and download files in order to continue with this
installation.

» If you are upgrading to this release from an earlier Smart View release, Oracle
recommends that you first uninstall the earlier release before installing this release.
See Uninstalling Smart View.

»  Ensure that Microsoft .NET Framework 4.5 or higher is installed on the computer
where you are installing Smart View.

Microsoft .NET Framework 4.5 or higher is required to install and use Smart View.
* Review the information in Installation Guidelines.
Close all Microsoft Office applications, including Outlook.
In EPM Workspace, select Tools, then Install, and then Smart View.

This takes you to the Oracle Smart View for Office software download page on Oracle
Technical Resources (OTR) here:

https://www.oracle.com/middleware/technologies/epm-smart-view-downloads.html
On OTR, click the Download Now link to begin the download process.

In the Smart View download prompt, click Oracle License Agreement and review to
ensure that your usage is compliant.

After reviewing the Oracle License Agreement, return to the Smart View software
download page and click the Download svc<version>.zip button to begin the download.

Using your browser's download procedures, save the file, and then unzip it to a
temporary location.

To start the installation wizard, in the temporary location from the previous step, right-click
SmartView.exe and select Run as administrator.

You may also double-click SmartView.exe to start the installation wizard; however, some
configurations may require Run as administrator. Therefore, Oracle recommends using
the Run as administrator command to ensure that all functionality is properly enabled
and all required Windows Registry entries are set. See Installation and Windows Access
Control Settings for more information.

Select a destination folder for Smart View, and then click OK.

For new installations, Smart View is installed by default in:

C:\Oracle\SmartView

If you are upgrading an existing installation of Smart View, the installer defaults to the
folder where Smart View was previously installed.
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< Note:

Oracle recommends installing in the default location or in a location that
does not contain any spaces in the installation path. For example, Oracle
advises that you do not install in C:\Program Files or C:\Program

Files (x86).

10. When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.

# Note:

Starting with Smart View 11.1.2.5.510, the Oracle Bl EE per-user
extension installer is included with the Smart View client installation. If
the extension is not already installed and it is not disabled, then it is
installed the first time you start Office.

11. If you plan to use drill-through reports or web launch, a browser add-on is required
for all supported browsers (Microsoft Edge, Mozilla Firefox, and Google Chrome).
See Installing Browser Add-ons for more information.

Installing from Oracle Bl EE

Related Topics
*  Configuring the Bl Home Page

* Installing from the Bl Home Page

Configuring the Bl Home Page

¢ Note:

Configuring a custom download link for the Smart View installer applies to
Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 and later versions,
and might not be available in earlier versions.

Starting in Oracle Bl EE release 11.1.1.9, the Smart View for MS Office link on the
Download Bl Desktop Tools drop-down list points to the Oracle Smart View for Office
download on Oracle Technology Resources (OTR).

If you do not want to direct your users to OTR, you can configure the Smart View for
MS Office link to point to a custom download link for the Smart View installer. You can
then ensure that the correct version of Smart View for your environment is always
available to your users. Do this by adding the SmartViewInstallerURL element to

instanceconfig.xml.

ORACLE 2-18



Chapter 2
Installing from Oracle Bl EE

You can configure the download link point to a location where the smartview.exe resides; for
example:

 An external URL

e Aninternal URL, such as internal web page or intranet location where the installation can
start immediately

« Afolder on alocal server where the installation can start immediately

To configure a custom download link for the Smart View installer:

1. Open the instanceconfig.xml file for editing

Refer to "Where Are Configuration Files Located?" in the Oracle Fusion Middleware
System Administrator's Guide for Oracle Business Intelligence Enterprise Edition.

2. Locate the CatalogPath and <DSN>AnalyticsWeb</DSN> sections and add the
SmartViewInstallerURL element after those sections.

3. Use the syntax in the following examples to add the SmartViewInstallerURL element.

Example for download from Oracle Technology Resources:

<CatalogPath>/example/path/work/abc/instances/instancel/bifoundation/
OracleBIPresentationServicesComponent/coreapplication obipsl/catalog/
SampleApp</CatalogPath>

<DSN>AnalyticsWeb</DSN>
<SmartViewInstallerURL>http://www.oracle.com/technetwork/middleware/epm/
downloads/smart-view-1112x-1939038.html</SmartViewInstallerURL>

Example for download from an intranet site:

<CatalogPath>/example/path/work/abc/instances/instancel/bifoundation/
OracleBIPresentationServicesComponent/coreapplication obipsl/catalog/
SampleApp</CatalogPath>

<DSN>AnalyticsWeb</DSN> <SmartViewInstallerURL>http://myserver:8080/
downloads/smartview.exe</SmartViewInstallerURL>

Example for download from an internal server:

<CatalogPath>/example/path/work/abc/instances/instancel/bifoundation/
OracleBIPresentationServicesComponent/coreapplication obipsl/catalog/
SampleApp</CatalogPath>

<DSN>AnalyticsWeb</DSN> <SmartViewInstallerURL>\
\myserver\downloads\smartview.exe</SmartViewInstallerURL>

4. Save your changes and close the file.

5. Restart the Oracle Bl EE instance.

Installing from the Bl Home Page

To install Oracle Smart View for Office from Oracle Business Intelligence Home:

1. Inthe Bl Home page, click the arrow next to Download Bl Desktop Tools, and then
select Smart View for MS Office.
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If you are directed to the Smart View download page on Oracle Technology
Resources, then follow the procedure in Installing from My Oracle Support or
Oracle Technical Resources. Otherwise, proceed with step 2.

2. Choose an option:
*  Click Run to run the installer directly.

If the User Account Control dialog box is displayed, click Yes, and then
continue to step 3.

» Click Save to save the Smart View installer file to a directory to which you
have access and from which you can run executable files.

Open the folder where you saved the Smart View executable and double-click
it to run it. Then continue to step 3.

Select the language to use for the installation wizard.
Click Next.

Follow the prompts in the wizard.

© o » w

When installation is complete, click Finish.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.

¢ Note:

Starting with Smart View 11.1.2.5.510, the Oracle Bl EE per-user
extension installer is included with the Smart View client installation.

The extension is installed the first time you start Office if the Oracle Bl
EE extension is not already installed and it is not disabled.

Running Command Line or Silent Installations

ORACLE

Oracle Smart View for Office can be installed from the command line.

Additionally, administrators can enable silent installations—installations that do not
require settings to be specified each time—for Smart View and Smart View extensions.
The silent installation command can be included in scripts to automate installation.

Related Topics:

* Before You Begin
e Command Line and Silent Installation Options
* Installing Using Command Line or Silent Install Options

* Installing Smart View Extensions Silently

Before You Begin

e Complete steps 3 and 4 in Installing from My Oracle Support or Oracle Technical
Resources to download the Smart View installation zip file and unzip it to the folder
you will be working in.
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» Oracle recommends ensuring that all Microsoft Office processes are terminated on the
machines where a silent installation or upgrade will be running. In Windows Task
Manager, the Office processes to check for and terminate are Excel, Word, PowerPoint,
and Outlook.

Command Line and Silent Installation Options

Use the options in Table 1 to install Smart View from the command line and for silent
installations.

Table 2-3 Options for Command Line and Silent Installations of Smart View

___________________________________________________________________________|
Option Usage

/v "command line options" Specifies command line options to be passed to
the Smart View MSI installer.
For example, to specify the installation directory,
use:

/v "INSTALLDIR=<target path>"

To enable logging, use:

/v "1*v <log file path and name>"

Unless the /v parameter contains any /g
specifier, the wrapper passes /gb+ to the MSI.

/s Runs the Smart View installer in silent mode.

The /s flag is converted to /gn and passed to the
MSI. There is no need to specify the /qn
parameter if /s is already present in your script.

INSTALLDIR=<target path> Specifies the installation directory.

# Note:

Oracle recommends
installing in the
default location or in
a location that does
not contain any
spaces in the
installation path. For
example, Oracle
advises that you do
not install in
C:\Program Files
or C:\Program
Files (x86).
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Table 2-3 (Cont.) Options for Command Line and Silent Installations of Smart View
]

Option Usage
/v"1*v <log file path and name>" Enables logging.
or Unless the /v parameter contains any /q

/v "1*v <log file path and name>" specifier, the wrapper passes /gb+ to the MSI.

# Note:

This command may
be used with or
without a blank
space after the
initial /v argument,
depending on what
works in your
environment.

/a Extracts the MSI file.

/i Specifies the path to the extension installer:

i <path to the extension installer>

For example:

svlaunch.exe /1
C:\Oracle\SmartView\extensions\SVFMJo
urnalInstaller.svext

See Installing Smart View Extensions Silently.
/extensionupdatelist= Path to UpdateList.xml.

/% Uninstalls Smart View.

Use this command to uninstall Smart View when it
has been installed or upgraded using the
command line or silent installer.

If Smart View was installed using the wizard
(described in Installing from My Oracle Support or
Oracle Technical Resources), then follow the
procedure in Uninstalling Smart View.
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< Note:

e The silent installer wrapper follows these rules:
— It passes the value of the /v parameter intact to the MSI.

— The /s flag is converted to /qn and passed to the MSI. There is no need to
specify the /qn parameter if /s is already present in your script.

— Unless the /v parameter contains any /q specifier, the wrapper
passes /qgb+ to the MSI.

e Silent installations are only supported for admin users.

Installing Using Command Line or Silent Install Options

To perform command line or silent installations:

1.
2.
3.

Open a command prompt using the "Run as administrator" option.

Navigate to the directory of the Smart View installer.

Run the installation commands in Table 1; for example:

To install in the default directory, run:
Silent:

SmartView.exe /s

Command line:
SmartView.exe

To install in another directory, run:
Silent:

SmartView.exe /s /v "INSTALLDIR=<target path>"

For example:

SmartView.exe /s /v "INSTALLDIR=D:\SmartView"

Command line:

SmartView.exe /v "INSTALLDIR=<target path>"

For example:
SmartView.exe /v "INSTALLDIR=D:\SmartView"

To specify the location of UpdateList.xml, run:
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Silent:

SmartView.exe /s /extensionupdatelist=<path to UpdateList.xml>

Command line:
SmartView.exe /extensionupdatelist=<path to UpdateList.xml>

To install Smart View and log the installation sequence:
Silent:

SmartView.exe /s /v"/L*v <log file path and name>"

For example:

SmartView.exe /s /v"/L*v C:\install.log"

SmartView.exe /s "/v/gn /L*v C:\install.log"

SmartView.exe /s /v"/gn INSTALLDIR=C:\Oracle\SmartView /L*v
c:\install.log"

Command line:

SmartView.exe /s /v"/L*v <log file path and name>"

For example:

SmartView.exe /s /v"/L*v C:\install.log"

SmartView.exe /v"/gn INSTALLDIR=C:\Oracle\SmartView /L*v
C:\install.log

SmartView.exe /v" INSTALLDIR=C:\Oracle\SmartView /L*v
C:\install.log"

To uninstall and log the uninstall sequence:

Silent:

SmartView.exe /x /s "/v /L*v C:\Share\uninstall.log"

Command line:

SmartView.exe /x "/v /L*v C:\Share\uninstall.log"
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Installing Smart View Extensions Silently

Administrators can push extension installations silently by calling the following command:

svlaunch.exe /i <path to the extension installer>

For example, after a typical Oracle Smart View for Office installation, Smart View is installed
on C:\Oracle\SmartView. In this installation, the extensions included with Smart View are
located in C:\Oracle\SmartView\extensions. Using the command above, an admin can
silently install the Oracle Journals extension using the following command:

svlaunch.exe /i C:\Oracle\SmartView\extensions\SVFMJournallInstaller.svext

After installation, the extension files are located on the user's machine here:

$APPDATA%\Oracle\SmartView\extensions\Bin

Exporting Default Smart View Options

As a service administrator, you can configure default Smart View options and roll them out to
users installing Oracle Smart View for Office. With this ability, you can ensure consistent
application of Smart View configurations across users in your organization.

You can export options present under Member Options, Data Options, Advanced, and
Formatting tabs available in the Options dialog. The exported options are stored in an
options.xml file at <Smart View Install>/cfq folder (for example,
C:\Oracle\SmartView\cfg). You can distribute this file to your users, so that they can get the
default options you set when they use Smart View.

" Note:

The following options cannot be exported:
e All options under Cell Styles tab and Extensions tab
e Following options under Advanced tab:
— Shared Connections URL
— Log Message Display
— Show Diagnostics Group on Smart View Ribbon
— Disable Smart View in Outlook
— Reduce Excel File Size
— Improve Metadata Storage

e The Member Display Name option under Member Options tab

To export default Smart View options and distribute to users:
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From the Smart View ribbon, click Options to open the Options dialog.

Set the options under the Member Options, Data Options, Advanced, and
Formatting tabs as per your requirement.

Expand the list under OK and select Export Options.

The configured options are exported in an options.xml file located at
C:\Oracle\SmartView\cfg. You can now distribute this options.xml file to the
users.

Use your organization's process to distribute the options.xml to all users who
require these options settings.

The options.xml file must reside in the Smartview\cfg folder on each user's
computer.

With the options.xml file in place, Smart View users take the following actions:
a. Launch an Office application; for example, launch Excel.
b. Selectthe Smart View ribbon, and then click Options.

c. Inthe Options dialog, click Reset.

< Note:

As a best practice, Oracle recommends that admins and users do
not modify the options in the options.xml file, as it can result in
errors and mismatch. If any changes are made manually to the
options.xml file, you may get the error message Option data
mismatch. Please check cfg/options.xml when you click Reset.

d. Close and reopen the Office application.

Smart View Options are now set to those specified by the service
administrator in the options.xml file.

Downloading Help for Local or Web Server Installation

After installing Oracle Smart View for Office, the online help is retrieved from a URL
hosted on the Oracle.com web site. This is the default behavior for Smart View, and no
changes are required by users to launch help.

ORACLE

However, you may require that the help be installed locally or on a web server in your
organization. Some examples for the need to access help from a location other than
Oracle.com are:

Help files must be installed on a local drive on an individual's computer for Section
508 accessibility purposes.

Internet access limitations; for example, your users only have access to URLs on
your organization's intranet.

To accommodate the above types of cases, a downloadable help zip file is posted on
My Oracle Support as a patch to the current Smart View release.

The procedure below describes downloading the help zip file. Further instructions for
installation and configuration are in the following guides:
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» Installing and Configuring Help Locally or on a Web Server in this guide.

*  Oracle Smart View for Office Accessibility Guide. See "Installing and Configuring Help
Locally."

To download the Smart View help zip file from My Oracle Support (MOS):
1. Loginto MOS.
2. Select the Patches & Updates tab.

The Patch Search area is displayed at the right of the screen with the Search tab
selected by default.

3. Click Product or Family (Advanced), then do the following:

a. Inthe Product is field, type Smart View.

b. Inthe Release is field, select the release from the drop-down list.
4. Click Search.
5. Download the online help patch zip file to a temporary directory.

6. To install and configure the help according to your requirements, follow the instructions in
either of the following guides:

» Installing and Configuring Help Locally or on a Web Server in this guide.

e Oracle Smart View for Office Accessibility Guide. See "Installing and Configuring
Help Locally."

Uninstalling Smart View

ORACLE

This topic describes uninstalling Oracle Smart View for Office. Use this procedure to uninstall
Smart View when it has been installed using the wizard (described in Installing from My
Oracle Support or Oracle Technical Resources).

If Smart View was installed using the command line or silent installer, then use the
commands described in Running Command Line or Silent Installations to uninstall.

< Note:

Non-admin users are not authorized to install Smart View in the C:\Program Files
or C:\Program Files (x86) folders. If a non-admin user has installed in one of
those folders, or any folder with spaces in the name, the Smartview folder will be
leftin the <installation location>\Oracle\ folder, and the properties.xml and
SVCRecentlyUsedItems.info files will be left in the
C:\Users\<user>\AppData\Roaming\Oracle\SmartView folder. These files will need
to be deleted manually. Or, an administrator can run a silent uninstall, which will
remove all files.

To uninstall extensions, see Uninstalling Extensions in the Oracle Smart View for Office
User's Guide.

To uninstall Smart View:

1. Before you begin, close all Office applications.
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2. In your Windows system Control Panel, click Programs and Features.

3. Locate and select the version of Smart View that applies to your installation:
* Oracle Smart View 32-bit for Office
e Oracle Smart View 64-bit for Office

4. Click Uninstall.
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Related Topics

»  About Extension Installations and Updates
e Configuring Manual Extension Updates

e Configuring Auto-Update Extensions

* Administering Extensions When Using Mozilla Firefox

About Extension Installations and Updates

ORACLE

The extension installation and update process described in this chapter enables Oracle
Smart View for Office end users to install, update, or uninstall extensions based on
parameters set by the Smart View administrator in the manifest file, UpdateList.xml.

Auto-Update versus Manual Update

In releases earlier than Smart View 11.1.2.5.400, extensions were updated using the Auto-
Update process. To update extensions with Auto-Update, Smart View end users could go to
the Extensions tab of the Options dialog box and click the Check for updates link or select
the Check for updates when Microsoft Office starts check box to initiate extension
updates. For all extensions, if any updates were available, they were retrieved and
installations were automatically initiated.

In release 11.1.2.5.400 and later, you can customize the extension update process so that
Smart View end users can control when they install, update, and remove extensions. The
Smart View administrator configures attributes in the UpdateList.xml manifest file to control
the options available to the users. If the administrator does not configure these attributes in
UpdateList.xml, extensions will continue to be updated using the existing Auto-Update
process.

Types of Extensions
There are two types of extensions that can be installed on a Smart View client machine:

e Provider extensions. Extensions that are dependent on, or integrated with, Oracle
components are provider extensions. Examples are the Disclosure Management and
Oracle Hyperion Financial Reporting extensions. Provider extensions can be configured
as required extensions.

e Per-user extensions. Extensions that are installed in the user’s application data folder.
These extensions may or may not be dependent on Oracle components. Additionally,
per-user extensions can also be configured as required extensions.

The Smart View administrator configures the UpdateList.xml file to specify the list of
provider and per-user extensions available to end users along with options for installing,
updating, and removing them. Additionally, per-user extensions can also be configured to
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display an indicator for required extensions and does not force the installation. The
Smart View end user then accesses the Options dialog box and installs, updates, or
uninstalls the extensions that are available to him or her in the Extensions tab.

To configure provider and per-user extension installation, uninstallation, and updating,
complete the procedure in Configuring Manual Extension Updates.

If you do not want to make changes to the extension update process, you may refer to
Configuring Auto-Update Extensions for information on the structure of the XML and
examples, but you do not need to take any further action.

For instructions on installing, updating, and removing extensions in Smart View, end
users can refer to the procedure topics in "Extensions" in the "Smart View Options”
chapter in the Oracle Smart View for Office User's Guide.

About the Oracle Journals for Financial Management Extension

The Oracle Journals extension is unique among Smart View extensions in that the
extension installer file is included in the extensions folder of the Smart View
installation. End users can install the Oracle Journals extension directly from the
extensions folder of their Smart View installation.

Or, as administrator, you can control how your Smart View end users install the Oracle
Journals extension, automatically or manually, via the Extensions page of the Smart
View Options dialog box.

If you choose to set up automatic or manual installations of the Oracle Journals
extension, you should install Smart View in a test environment first, then refer to the
UpdateList.xml file, found in the extensions folder of your Smart View installation.
Use the entry in this file as a guideline for the Oracle Journals entry you will add to the
Updatelist.xml file, as described in Configuring Manual Extension Updates.

Configuring Manual Extension Updates

ORACLE

Auto-Update extensions in the UpdateList.xml manifest file can be configured so that
the Oracle Smart View for Office end user can see the available extensions, including
per-user extensions, and install them from the Extensions tab of the Options dialog
box.

You can add two attributes, visible and allowUninstall, to the UpdateList.xml
manifest file to change the behavior of the extensions from auto-update to manual
update so that the extensions are displayed in the Options dialog box:

* visible—A value of "1" indicates that the extension will appear in the Extensions
tab of the Smart View Options dialog and will NOT be part of the Auto-Update
process.

If the visible attribute is missing or the value is not "1", the extension is included
in the Auto-Update process.

e allowUninstall—A value of "1" indicates that the user can initiate an uninstall
through the Extensions tab of the Options dialog box using the Remove link.

If the allowUninstall attribute is missing or the value is not "1", the user may not
initiate an uninstall in the Extensions interface (the Remove link will not be there).

This procedure is optional. If you choose not to add the attributes to Updatelist.xml,
extensions will continue to be updated as they were in releases earlier than
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11.1.2.5.400. In pre-11.1.2.5.400 releases, users click the Check for updates link or select
the Check for updates when Microsoft Office starts check box to initiate extension
updates.

See Manual Update XML Defined and Manual Update XML Example for reference.
To add attributes to the UpdateList.xml manifest file for extensions:

1. Open the UpdateList.xml file for editing.
The manifest file is found in two locations:

* epmstatic:
http://server:port/epmstatic/smartview/Client/UpdatelList.xml

e The location pointed to by the <extensionupdatelist>tag in
C:\Oracle\SmartView\cfg\properties.xml.

To populate the <extensionupdatelist> tag, you can either perform a command line
installation, as described in Running Command Line or Silent Installations, or
manually update the tag in the properties.xml file.

" Note:

In properties.xml, if multiple URLs exist for an extension installer, Smart
View checks all locations and installs from the location containing the latest
version.

If multiple URLSs exist for the same version of an extension installer, Smart
View installs from the first URL in the list.

2. Optional: To display an extension in the Extensions tab of the Options dialog box, and
exclude the extension from the Auto-Update process, add the visible="1" attribute to
the XML for the extension; for example:

<update>
version="11.1.2.3.500.021"
extension id="Some.Unique.Id.That.Matches.Extension.Descriptor.Id"
location="/epmstatic/disclosure mgmt/svext/DiscManSetup.msi"
visible="1"
allowUninstall="1">Oracle Disclosure Management

</extension>

Figure 1 shows an example of an extension displayed in the Extensions tab.

Figure 3-1 Extension as Displayed in the Extensions Tab

Oracle Predictive Planning 11.1.2.4.000 [#] Enabled
Oracle Predictive Planning Smart View Extension

# |pdate Svailable
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Optional: To display the Remove button, ﬁ Remove | for an extension, add the
allowUninstall="1" attribute to the XML for the extension; for example:

<update>
version="11.1.2.3.500.021"
extension id="A.Unique.Id.That.Matches.Extension.Descriptor.Id"
location="/epmstatic/disclosure mgmt/svext/DiscManSetup.msi"
visible="1"
allowUninstall="1">Oracle Disclosure Management

</extension>

Figure 2 shows an example of an extension displayed in the Extensions tab.

Figure 3-2 Extension as Displayed in the Extensions Tab

Oracle Predictive Planning 11.1.2.4.000 [#] Enabled ﬁ Remaove
Oracle Predictive Planning Smart View Extension

# |pdate Available

For each provider and per-user extension, repeat step 2 and step 3 according to
your requirements.

Optional: To remove a single extension from the list of extensions available for
Auto-Update in the UpdateList.xml file, use the alternative method of commenting
out the extension with the <!-- and --> characters; for example:

<!--

<extension>

location="/epmstatic/disclosure mgmt/svext/DiscManSetup.msi"
version="11.1.2.4.078" id="nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn">
Oracle Disclosure Management

</extension>

-—>

You can also comment out the entire list of extensions if your goal is to exclude all
extensions from the manual update process.

Manual Update XML Defined

ORACLE

<update>
The root node. This is a tag.
<extension>
Parent node for <extension> attributes. This is a tag.
Attributes of <extension> are:
- id
The extension identifier. The identifier must match the

SVExtensionDescriptor.GUID defined in the extension. It does not need to be
a GUID, it only needs to be unique. This name will appear in the Windows
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Registry. For this reason, Oracle recommends using readable identifiers; for
example, Oracle.Disclosure.Management.

— format

A value of "1" indicates that the entry for the extension uses the manual update XML
format introduced in Oracle Smart View for Office 11.1.2.5.400. This XML format
supports more user interface features than the standard Auto-Update format.

— version

The version number of the extension. The version number must match exactly with
the extension descriptor version in the extension assembly.

— svVersion
The Smart View version that the extension works with.
— visible

Set this value to "1" to display the extension in the Extensions tab of the Options
dialog box. When this is set to "1", the extension will NOT be part of the Auto-Update
process.

— manualUpdate

Set this value to "1" if the user needs to close Excel for installation update. The
update installer file will be downloaded and a message will be displayed indicating
the required restart of Office. Also, the download folder will be opened.

— manuallnstall

Set this value to "1" if the user needs to close Excel for installation. The installer file
will be downloaded and a message will be displayed indicating the required restart of
Office. The download folder will be opened.

— allowUninstall

Set this value to "1" to display the Remove button in the Extensions tab of the
Options dialog box.

- type
The type of extension. Valid values are:
* 0 = optional extension
* 1 = provider extension
* 2 =Smart View client
— required

Set to display a "Required" or "Recommended" icon for the extension. No action is
done other than the visible icon.

<name>
The name of the extension. This is a tag.
<desc>

The extension description. This is a tag.

Uses the "default” attribute. The default description for the extension will be the
description displayed in the Extensions tab.

owner
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The creator or owner of the extension; for example, Oracle.
* location

The location and file name of the extension installer file. This can be msi or svext;
exe IS not supported.

*  <uninstallMsg>
Optional. For uninstalls, displays a custom message to the user.

Uses the "default" attribute. The default description for the uninstallMsg will be the
custom message displayed during uninstall.

e <options>

Optional. For msi installations only. All options for the Microsoft Windows Installer
Tool, Msiexec.exe, are supported.

Manual Update XML Example

<update>
<extension id="Oracle.SmartView.ExtensionSamples.PowerPack.AdjustData"
format="1"
version="1.1.3.0"
svVersion="11.1.2.2.310"
visible="1" allowUninstall="1"
manualUpdate="0"
manualInstall="0"
type="0"
required="1">
<name>Adjust Data</name>
<desc default="Simple data adjustment panel for use with Smart View">
<owner>Oracle</owner>
<location>file://server name/shared/ExtensionInstallers/
AdjustDatalnstaller.svext
</location>
<uninstallMsg default="This will remove the extension and all its
components"”
</uninstallMsg>
</extension>
</update>

Configuring Auto-Update Extensions

ORACLE

You can add the visible and allowUninstall attributes to the UpdateList.xml
manifest file to change the behavior of the extensions that are part of the Auto-Update
process.

If you do not add the attributes to UpdateList.xml, extensions will continue to be
updated using the existing Auto-Update process.

To add the visible and allowUninstall attributes to the Auto-Update extensions,
complete the procedure in Configuring Manual Extension Updates.

See Auto-Update XML Defined and Auto-Update XML Example for reference.
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You can also remove an single extension from the list of extensions available for Auto-Update
in the UpdateList.xml file by commenting out the extension using the <!-- and -->
characters. For example:

<l--

<extension>

location="/epmstatic/disclosure mgmt/svext/DiscManSetup.msi"
version="11.1.2.4.078" id="nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn"> Oracle
Disclosure Management

</extension>

-—>

If you comment out the entire list of extensions, then all extensions are excluded from the
manual update process.

Auto-Update XML Defined

e <update>
The root node. This is a tag.
* <extension>

Text that contains the extension name. This is a tag. The extension name appears in the
Extensions tab of the Options dialog box. Examples of extension names are Oracle
Predictive Planning Extension, Disclosure Management, or Adjust Data.

Attributes of <extension> are:

- id
The extension identifier. The identifier must match the SVExtensionDescriptor.GUID
defined in the extension. It does not need to be a GUID, it only needs to be unique.

This name will appear in the Windows Registry. For this reason, Oracle recommends
using readable identifiers; for example, Oracle.Disclosure.Management.

— version
The version number of the extension.
— location

The location and file name of the extension installer file. This can be msi or svext;
exe is not supported.

— operation

Optional. For Auto-Updates, set this value to "delete" to have the uninstall
automatically begin when the user opens Office.

# Note:

The first time a user opens Office, if Oracle Smart View for Office
determines that the extension needs to be uninstalled, the subsequent
opening of Office initiates the uninstall process.

— options
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Optional. For msi installations only. All options for the Microsoft Windows
Installer Tool, Msiexec.exe, are supported.

— visible

Set this value to "1" to display the extension in the Extensions tab of the
Options dialog box. When this is set to "1", the extension will NOT be part of
the Auto-Update process.

— allowUninstall

Set this value to "1" to display the Remove button in the Extensions tab of
the Options dialog box.

Auto-Update XML Example

<update>

<extension id="A.Unique.Id.That.Matches.Extension.Descriptor.Id"
version="11.1.2.3.500.021"
location="/epmstatic/disclosure mgmt/svext/DiscManSetup.msi"
visible="1"
allowUninstall="1">Disclosure Management

</extension>

<extension id="Another.Unique.Id"
version="11.1.2.3.300"
location="/epmstatic/SomeSetup.msi"
operation="delete">Crystal Ball EPM
</extension>

<extension id="And.Another.Unique.Id"
version="11.1.2.3.300"
location="/epmstatic/SomeSetup.msi"
options="/promptrestart">Oracle Predictive Planning"

</extension>

</update>

Administering Extensions When Using Mozilla Firefox

ORACLE

When using Mozilla Firefox, keep in mind the following:

»  Firefox prevents executable files from being copied and installed from the Internet.
This results in a failure while attempting to install an . SVEXT extension package
with Firefox by selecting the Open with option. As a result, when prompted to
save or run the file, select the Save option, and then double-click the downloaded
file to install the extension .

*  When using Firefox as your web browser to launch Oracle Smart View for Office,
and Firefox opens a browser tab in with an unresolved URL of oraclesv:\\,
enable the extension for Smart View from the Extensions tab of Firefox Add-ons
Manager and restart Firefox.
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File

Related Topics
e About Accessing Shared Connections from an XML File
e Setting Up the Shared Connections XML File

e Connection File Syntax and Example

About Accessing Shared Connections from an XML File

ORACLE

You can use private connection information stored in an XML file to connect to supported
Oracle Smart View for Office providers, both cloud and on-premises, using a shared
connection. You can add entries for:

e Oracle Enterprise Performance Management Cloud data sources, including Planning,
Planning Modules, Financial Consolidation and Close, Tax Reporting, and Narrative
Reporting

e Oracle Enterprise Performance Management System data sources, including Oracle
Hyperion Provider Services (Oracle Essbase), Oracle Hyperion Planning, Oracle
Hyperion Financial Management, Oracle Hyperion Reporting and Analysis, Oracle
Hyperion Strategic Finance

*  Oracle Essbase
e Oracle Business Intelligence Enterprise Edition and Oracle Analytics Cloud

The XML file can exist either locally on each individual Smart View client machine or on a
web server. Smart View end users point to this XML file in the Shared Connections URL
field of the Options dialog box, and then access the available providers as they would any
other shared connection to which they have access.

To connect to an Oracle Bl EE or Oracle Analytics Cloud provider from the Shared
Connections Panel in Smart View, you must follow the procedures in this topic. However, you
may also connect to Oracle Bl EE or Oracle Analytics Cloud data sources from the Private
Connections Panel using the procedures in Creating Private Connections in the Oracle Smart
View for Office User's Guide.

¢ Note:

Only ASCII characters are supported in the XML file. Do not use non-ASCII
characters in any of the entries you make in this file.
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Caution:

The procedures in this chapter should be completed by the Smart View
administrator.

Setting Up the Shared Connections XML File

Setting up the shared connections XML file involves preparing the XML file distributing
it to your users.

To set up shared connections in an XML file:

1. Create an empty XML file using any text editor and save it on your Oracle Smart
View for Office client machine.

Give the file a meaningful name, such as SmartViewProviders.xml, and ensure
that it has the .xml extension.

¢ Note:

Only ASCII characters are supported in the XML file. Do not use non-
ASCII characters in any of the entries you make in this file.

2. Add the following line to the beginning of the file:
<?xml version="1.0" encoding="UTF-8"?2>

3. Next, add the opening res_GetProvisionedDataSources tag:
<res GetProvisionedDataSources>

4. Add entries for the applicable providers.

The XML can contain entries for supported Oracle Enterprise Performance
Management Cloud and Oracle Analytics Cloud data sources, and supported
Oracle Enterprise Performance Management System and Oracle Business
Intelligence Enterprise Edition data sources.

¢ Note:

Entries for each connection use the private connection format.

When you create your entries, copy the syntax exactly and make ONLY these
substitutions:

* Inthe Product tag, name attribute:
name—AnN internal identifier for the provider. This will not display to users.

* Inthe Product tag, displayVersion attribute:
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version—The version number of the specified provider. This will not display to users.
e Inthe Server tag, name attribute:

name—The application name the user will see in the Shared Connection drop-down
list.

# Note:

This property does not apply to Essbase. The name that appears in the
drop-down list will always be Oracle® Essbase.

* Inthe Server tag, context attribute:
serviceURL—The URL for a cloud data source connection.

webServerHost—The web server host machine name for an on-premises data source
connection.

webServerPort—The web server port number for an on-premises data source
connection. Use the default port number that is already noted in the syntax for each
provider. Or, if you have configured your system using non-default port numbers,
provide them.

The syntax for each provider type is below.
Planning in EPM Cloud

<Product id="HP" name="name" displayVersion="version">

<Server name="Planning" context="https://serviceURL/HyperionPlanning/
SmartView"></Server>

</Product>

Planning Modules in EPM Cloud

<Product id="HP" name="name" displayVersion="version">
<Server name="Planning Modules" context="https://serviceURL/
HyperionPlanning/SmartView"></Server>

</Product>

FreeForm in EPM Cloud

<Product id="HP" name="name" displayVersion="version">

<Server name="FreeForm" context="https://serviceURL/HyperionPlanning/
SmartView"></Server>

</Product>

Financial Consolidation and Close in EPM Cloud

<Product id="HP" name="name" displayVersion="version">

<Server name="Financial Consolidation and Close" context="https://
serviceURL/HyperionPlanning/SmartView"></Server>

</Product>
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Tax Reporting in EPM Cloud

<Product id="HP" name="name" displayVersion="version">
<Server name="Tax Reporting" context="https://serviceURL/
HyperionPlanning/SmartView"></Server>

</Product>

Enterprise Profitability and Cost Management in EPM Cloud

<Product id="HP" name="name" displayVersion="version">
<Server name="Enterprise PCM" context="https://serviceURL/
HyperionPlanning/SmartView"></Server>

</Product>

Narrative Reporting in EPM Cloud

<Product 1id="EPRCS" name="name" displayVersion="version">

<Server name="Narrative Reporting" context="https://serviceURL/epm/
SmartView"> </Server>

</Product>

Reporting Settings in EPM Cloud)

<Product id="RAFramework" name="name" displayVersion="version">
<Server name="Reporting Settings" context="https://serviceURL/hr/
modules/com/hyperion/reporting/web/repository/HRRepositoryXML. jsp

Oracle Analytics Cloud

<Product providerType="ExtensionProvider" id="27EE9BOD-D5F5-42c9-
AFC5-44FEA770C693" name="name" displayVersion="version">

<Server name="Oracle Analytics Cloud" context="OBI:https://
serviceURL/analytics/jbips"></Server>

</Product>

Oracle Essbase or other cloud version of Essbase

<Product 1id="APS" name="name" displayVersion="version">

<Server name="Oracle® Essbase" context="https://serviceURL/essbase/
smartview"></Server>

</Product>

Oracle Hyperion Provider Services (for on-premises Oracle Essbase)

<Product id="APS" name="name" displayVersion="version">
<Server name="Oracle® Essbase" context="http(s)://
webServerHost:webServerPort/aps/SmartView"></Server>
</Product>
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Oracle Hyperion Planning

<Product id="HP" name="name" displayVersion="version">

<Server name="Oracle Hyperion Planning, Fusion Edition"
context="http(s)://webServerHost:webServerPort/HyperionPlanning/
SmartView"></Server>

</Product>

Oracle Hyperion Financial Management

<Product id="HFM" name="name" displayVersion="version">

<Server name="Oracle Hyperion Financial Management, Fusion Edition"
context="http(s)://webServerHost:webServerPort/hfmadf/../
hfmofficeprovider/HFMOfficeProvider.aspx"></Server>

</Product>

Oracle Hyperion Reporting and Analysis Framework, Reporting Settings (for on-premises
Release 11.1.2.4.9xx and later)

<Product id="RAFramework" name="name" displayVersion="version">
<Server name="Reporting and Analysis Framework" context="http(s)://
webServerHost:webServerPort/hr/modules/com/hyperion/reporting/web/
repository/HRRepositoryXML. jsp

Oracle Hyperion Reporting and Analysis (for on-premises Release 11.1.2.4.7xx and
earlier)

<Product id="RAFramework" name="name" displayVersion="version">
<Server name="Reporting and Analysis Framework" context="http(s)://
webServerHost:webServerPort/raframework/browse/1istXML"></Server>
</Product>

Oracle Hyperion Strategic Finance

<Product providerType="ExtensionProvider" id="HSF" name="name"
displayVersion="version">

<Server name="Oracle Hyperion Strategic Planning, Fusion Edition"
context="http(s) ://webServerHost:webServerPort/StrategicPlanning/
SmartView"></Server>

</Product>

Oracle Bl EE

<Product providerType="ExtensionProvider" id="27EE9BOD-D5F5-42c9-
AFC5-44FEA770C693" name="name" displayVersion="version">

<Server name="Oracle BI, Fusion Edition" context="OBI:http(s)://
webServerHost:webServerPort/analytics/jbips"></Server>

</Product>

Optional: If you are planning to access help locally or from an internal URL, add an entry
for locating the help:
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* Help installed on a local drive:

<helpurlcontext>file:///parent language folder path/</
helpurlcontext>

For example:

<helpurlcontext>file:///C:/Oracle/SmartView/smartview help/</
helpurlcontext>

e Help installed on a web server:

<helpurlcontext>http://webServerHost:webServerPort/
pathToHelpFiles/smartview help/</helpurlcontext>

For example:

<helpurlcontext>http://abcxyzco.com:12345/user documentation/
smartview help/</helpurlcontext>

Notes:

»  Perform this step ONLY if you are planning to access shared connections from
an XML file AND are required to access help either from a local drive or a web
server within your organization. See Installing and Configuring Help Locally or
on a Web Server for instructions on setting up help.

* If you use the <helpurlcontext> tag, the help location you specify overrides
the default or modified location specified in the <helpurlcontext> tag in the
properties.xml file, as described in Optional Local Help Configuration via the
Shared Connections XML File.

Optional: Add an entry for the User Productivity Kit (UPK):

<UPK>http://link to User Productivity Kit</UPK>

For example:

<UPK>http://download.abcxyzco.com/ocomdocs/PlayerPackage/data/
toc.html</UPK>

Add the closing res_GetProvisionedDataSources tag to complete the file, then
save it.

</res_GetProvisionedDataSources>

See Connection File Syntax and Example for the full syntax and an example of
how this file should be set up.

Test the file:
a. Perform an action:

» If you plan to have users copy the XML file to their local drive, ensure that
the file is copied to a local drive on your Smart View client machine.
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For example, the file may be copied to the Smartview\bin directory.

* Alternatively, if you plan to copy the file to a web server, ensure that the file is
accessible to your users from a fully-qualified URL that includes the XML file
name and the .xml extension.

b. Start Smart View and in the Options dialog box, edit the Shared Connections URL
to add the full path to the file or a URL, ensuring that the . xnl file name extension is
included.

# Note:

This feature will not work if the . xm1 file name extension in not included at
the end of the local drive path or URL.

* Local drive example:

C:/Oracle/SmartView/bin/SmartViewProviders.xml

Ensure that you use forward slashes (/) as separators in the file path.

The directory path and file should now be available in the list of shared
connections.

*  Web server URL syntax:

http://webServerHost:webServerPort/pathToFile/filename.xml

Web server URL example:

http://<webServerHost>:<webServerPort>/SmartViewDataSources/
SmartViewProviders.xml

The URL should now be available in the list of shared connections.

c. Connect to the file using the Shared Connections option in the Smart View Panel,
as described in "Connecting to Data Sources" in the Oracle Smart View for Office
User's Guide.

If you do not see provider entries listed in the Shared Connections drop-down list,
then the XML file may contain incorrect syntax or invalid characters.

Tip:

Verify the XML by opening the file in a browser; for example, in Microsoft
Edge. The browser will specify the invalid syntax. Correct any errors in the
XML file editor, save, and refresh the browser display.

9. When the XML file is correct and complete, perform one of the following procedures:

» If you plan to have users copy the XML file to their local drive, distribute the file to
your Smart View users with these instructions:

ORACLE 47



a.

b.

Chapter 4
Connection File Syntax and Example

Do not modify this file in any way.
Copy the file to a local drive on your Smart View client machine.
For example, the file may be copied to the Smartview\bin folder.

Start Smart View and in the Options dialog box, edit the Shared
Connections URL with the full path to the file on the local drive, including
the file name and .xml extension; for example:

C:/Oracle/SmartView/bin/SmartViewProviders.xml

Ensure that you use forward slashes (/) as separators in the file path.

The directory path and file is now available in the list of shared
connections.

Test by connecting to the file using the Shared Connections option in the
Smart View Panel, as described in "Connecting to Data Sources" in the
Oracle Smart View for Office User's Guide.

If you have problems connecting, contact your Smart View administrator.

* If you plan to copy the XML file to a web server, notify your Smart View users
with these instructions:

a.

Start Smart View and in the Options dialog box, edit the Shared
Connections URL with the URL provided, including the file name
and .xml extension; for example:

http://abcxyzcowebserver:1234/SmartViewDataSources/
SmartViewProviders.xml

Test by connecting to this URL using the Shared Connections option in the
Smart View Panel, as described in "Connecting to Data Sources" in the
Oracle Smart View for Office User's Guide.

If you have problems connecting, contact your Smart View administrator.

Complete the procedure in Clearing Smart View Cookies.

Connection File Syntax and Example

Related Topics

Connection File Syntax

Connection File Example

Connection File Syntax

ORACLE

Below is the file syntax in its entirety:

<?xml version="1.0" encoding="UTF-8"?>
<res GetProvisionedDataSources>

<Product id="APS" name="name" displayVersion="version">
<Server name="Oracle Hyperion Provider Services" context="http://
webServerHost:webServerPort/aps/SmartView"></Server>
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</Product>

<Product id="HP" name="name" displayVersion="version">

<Server name="Oracle Hyperion Planning, Fusion Edition" context="http://
webServerHost:webServerPort/HyperionPlanning/SmartView"></Server>
</Product>

<Product id="HFM" name="name" displayVersion="version">

<Server name="Oracle Hyperion Financial Management, Fusion Edition"
context="http://webServerHost:webServerPort/hfmadf/../hfmofficeprovider/
HFMOfficeProvider.aspx"></Server>

</Product>

<!-- For on-premises Release 11.1.2.4.9xx and later -->

<Product id="RAFramework" name="name" displayVersion="version">

<Server name="Reporting Settings" context="http://
webServerHost:webServerPort/hr/modules/com/hyperion/reporting/web/repository/
HRRepositoryXML"></Server>

</Product>

<!-- For on-premises Release 11.1.2.4.7xx and earlier -->
<Product id="RAFramework" name="name" displayVersion="version">
<Server name="Reporting and Analysis Framework" context="http://
webServerHost:webServerPort/raframework/browse/1istXML"></Server>
</Product>

<!-- For EPM Cloud -->

<Product id="RAFramework" name="name" displayVersion="version">

<Server name="Reporting Settings" context="https://serviceURL/hr/modules/com/
hyperion/reporting/web/repository/HRRepositoryXML"></Server>

</Product>

<Product providerType="ExtensionProvider" id="name" name="HSF-11.1.2"
displayVersion="version">

<Server name="Oracle Hyperion Strategic Planning, Fusion Edition"
context="http(s)://webServerHost:webServerPort/StrategicPlanning/
SmartView"></Server>

</Product>

<Product providerType="ExtensionProvider" id="27EE9BOD-D5F5-42c9-
AFC5-44FEA770C693" name="name" displayVersion="version">

<Server name="Oracle BI, Fusion Edition" context="OBI:http://
webServerHost:webServerPort/analytics/jbips"></Server>

</Product>

<Product id="HP" name="name" displayVersion="version">

<Server name="Planning" context="https://serviceURL/HyperionPlanning/
SmartView"></Server>

</Product>

<Product id="HP" name="name" displayVersion="version">

<Server name="Planning Modules" context="https://serviceURL/HyperionPlanning/
SmartView"></Server>

</Product>
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<Product id="HP" name="name" displayVersion="version">

<Server name="FreeForm" context="https://serviceURL/HyperionPlanning/
SmartView"></Server>

</Product>

<Product id="HP" name="name" displayVersion="version">

<Server name="Financial Consolidation and Close" context="https://
serviceURL/HyperionPlanning/SmartView"></Server>

</Product>

<Product id="HP" name="name" displayVersion="version">
<Server name="Tax Reporting" context="https://serviceURL/
HyperionPlanning/SmartView"></Server>

</Product>

<Product id="HP" name="name" displayVersion="version">
<Server name="Enterprise PCM" context="https://serviceURL/
HyperionPlanning/SmartView"></Server>

</Product>

<Product 1id="EPRCS" name="name" displayVersion="version">

<Server name="Narrative Reporting" context="https://serviceURL/epm/
SmartView"></Server>

</Product>

<Product id="HP" name="name" displayVersion="version">
<Server name="Tax Reporting" context="https://serviceURL/
HyperionPlanning/SmartView"></Server>

</Product>

<Product providerType="ExtensionProvider" id="27EE9BOD-D5F5-42c9-
AFC5-44FEA770C693" name="name" displayVersion="version">

<Server name="Oracle Analytics Cloud" context="OBI:https://serviceURL/
analytics/jbips"></Server>

</Product>

<Product 1id="APS" name="name" displayVersion="version">

<Server name="Oracle Analytics Cloud - Essbase" context="https://
serviceURL/essbase/smartview"></Server>

</Product>

<helpurlcontext>a valid entry as per optional step 5</helpurlcontext>

<UPK>http://link to User Productivity Kit</UPK>

</res_GetProvisionedDataSources>
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The following example includes an entry for each provider type and also includes an entry for
accessing help from an organization's internal web server:

<?xml version="1.0" encoding="UTF-8"?>
<res_GetProvisionedDataSources>

<Product id="APS" name="APS-11.1.2" displayVersion="11.1.2.4.500">
<Server name="Oracle Hyperion Provider Services" context="http(s)://
<webServerHost>:19000/aps/SmartView"></Server>

</Product>

<Product id="HP" name="HP-11.2" displayVersion="11.2.5">

<Server name="Oracle Hyperion Planning, Fusion Edition" context="http(s)://
<webServerHost>:19000/HyperionPlanning/SmartView"></Server>

</Product>

<Product id="HFM" name="HFM-11.2" displayVersion="11.2.5">

<Server name="Oracle Hyperion Financial Management, Fusion Edition"
context="http(s)://<webServerHost>:19000/hfmadf/../hfmofficeprovider/
HFMOfficeProvider.aspx"></Server>

</Product>

<!-- For on-premises Release 11.1.2.4.9xx and later -->

<Product id="RAFramework" name="RAFramework-11.1.2.4"
displayVersion="11.1.2.4.9xx">

<Server name="Reporting Settings" context="http(s)://
<webServerHost>:<<webServerPort>/hr/modules/com/hyperion/reporting/web/
repository/HRRepositoryXML"></Server>

</Product>

<!-- For on-premises Release 11.1.2.4.7xx and earlier -->

<Product id="RAFramework" name="RAFramework-11.1.2.4.7"
displayVersion="11.1.2.4.7xx">

<Server name="Reporting and Analysis Framework" context="http(s)://
<webServerHost>:<webServerPort>/raframework/browse/listXML"></Server>
</Product>

<!-- For EPM Cloud -->

<Product id="RAFramework" name="RAFramework-21.05" displayVersion="21.05">
<Server name="Reporting Settings" context="http://<serviceURL>/hr/
modules/com/hyperion/reporting/web/repository/HRRepositoryXML"></Server>
</Product>

<Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2"
displayVersion="11.1.2.2.00.2266">

<Server name="Oracle Hyperion Strategic Planning, Fusion Edition"
context="http(s)://<webServerHost>:8900/StrategicPlanning/SmartView"></
Server>

</Product>

<Product providerType="ExtensionProvider" id="27EE9BOD-D5F5-42c9-
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AFC5-44FEA770C693" name="OBI EE-11.1.1.7" displayVersion="11.1.1.7">
<Server name="Oracle BI, Fusion Edition" context="OBI:http(s)://
<webServerHost>:9704/analytics/jbips"></Server>

</Product>

<Product id="HP" name="PBCS" displayVersion="22.06">

<Server name="Planning" context="https://<serviceURL>/HyperionPlanning/
SmartView"></Server>

</Product>

<Product id="HP" name="EPBCS" displayVersion="22.06">

<Server name="Planning Modules" context="https://<serviceURL>/
HyperionPlanning/SmartView"></Server>

</Product>

<Product id="HP" name="FF" displayVersion="22.06">

<Server name="FreeForm" context="https://<serviceURL>/HyperionPlanning/
SmartView"></Server>

</Product>

<Product 1id="EPRCS" name="NR" displayVersion="21.05">

<Server name="Narrative Reporting" context="https://<serviceURL>/epm/
SmartView"></Server>

</Product>

<Product 1id="HP" name="FCCS" displayVersion="22.06">

<Server name="Financial Consolidation and Close" context="https://
<serviceURL>/HyperionPlanning/SmartView"></Server>

</Product>

<Product 1id="HP" name="TRCS" displayVersion="22.06">
<Server name="Tax Reporting" context="https://<serviceURL>/
HyperionPlanning/SmartView"></Server>

</Product>

<Product id="HP" name="EPCM" displayVersion="22.06">

<Server name="Enterprise PCM" context="https://<serviceURL>/
HyperionPlanning/SmartView"></Server>

</Product>

<Product providerType="ExtensionProvider" id="27EE9BOD-D5F5-42c9-
AFC5-44FEA770C693" name="OAC 22.06" displayVersion="22.06">
<Server name="Oracle Analytics Cloud" context="OBI:https://
<serviceURL>/analytics/Jjbips"></Server>

</Product>

<Product 1id="APS" name="Essbase" displayVersion="22.06">
<Server name="Oracle Analytics Cloud - Essbase" context="https://
<serviceURL>/essbase/smartview"></Server>

</Product>

<helpurlcontext>http (s)://<webServerHost>:<port>/user documentation/
smartview help/</helpurlcontext>

<UPK>http(s) ://download.<webServerHost>/ocomdocs/PlayerPackage/data/
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toc.html</UPK>

</res_GetProvisionedDataSources>
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Installing and Configuring Help Locally or on a
Web Server

Related Topics
* About Installing Help Locally or on a Web Server
e Setting Up Help Locally or on a Web Server

e Optional Local Help Configuration via the Shared Connections XML File

About Installing Help Locally or on a Web Server

After installing Oracle Smart View for Office, the online help is accessed from a URL hosted
on the Oracle.com web site. This is the default behavior for Smart View, and no changes are
required by users to launch help.

However, you may require that the help be installed locally or on a web server in your
organization. Some examples for the need to access help from a location other than
Oracle.com are:

* Help files must be installed on a local drive on an individual's computer for Section 508
accessibility purposes.

* Internet access limitations; for example, your users only have access to URLs on your
organization's intranet.

To accommodate the above types of cases, a help zip file can be downloaded from My
Oracle Support. You unzip the help to a local drive or web server, and then modify the Smart
View properties.xml file to point the help location.

# Note:

Depending on your requirements, you may also want to specify the
<helpurlcontext> tag in a shared connections XML file, as described in Setting Up
the Shared Connections XML File of Accessing Shared Connections from an XML
File. Refer to Optional Local Help Configuration via the Shared Connections XML
File for more information.

Setting Up Help Locally or on a Web Server

ORACLE

To install and configure Oracle Smart View for Office help locally or on a web server:

1. Obtain the help zip file for this release from My Oracle Support.

2. Extract the contents to either a local folder on the computer where Smart View is installed
or to a folder accessible by your users on an HTTP web server in your organization.

For example:
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» Extract the contents locally to:

C:\Oracle\SmartView\

The extraction adds an additional folder named smartview help. The result is:

C:\Oracle\SmartView\smartview help
e Extract the contents to a web server:

http://webServerHost:webServerPort/pathToHelpFiles

The extraction adds smartview help after pathToHelpFiles. The result is:

http://webServerHost:webServerPort/pathToHelpFiles/smartview help
Under the smartview help folder, there are 28 language folders; for example:

C:\Oracle\SmartView
\smartview help
\ar
\cs
\da
\de
\el
\en
\es
\fi
\fr
\fr CA
\he
\hu
\it
\ja
\ko
\nl
\no
\pl
\pt
\pt_BR
\ro
\ru
\sk
\sv
\th
\tr
\zh CN
\zh TW
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The following language folders contain translated versions of the Smart View help:

\de
\es
\fr
\it
\ja
\ko
\nl
\pt BR
\zh CN
\zh TW

The remaining language folders contain the English version of the help. When you run
Smart View in one of those languages (for example, Swedish) and you click a button for
Help, the English help is displayed.

Additionally, the English folder contains a copy of the help in PDF format,
smartview user.pdf

3. Modify the helpurlcontext property in the Smart View properties.xml file:

a.
b.

C.

ORACLE

In your Smart View installation, navigate to the Smartview\cfg folder.

Make a backup copy of the original properties.xml file.

Open properties.xml for editing.

Modify the helpurlcontext property, providing the path to the folder that is parent to
the language folders using the following syntax:

If installing locally, provide the path to the folder that is parent to the language
folders using the following syntax:

<helpurlcontext>file:///parent language folder path/</
helpurlcontext>

Tip:

Use forward slashes in the syntax and ensure that you enter a final
forward slash (/) after the parent language folder path that you provide.

Using the example from step 2, after extracting the zip contents to
C:\Oracle\SmartView, the smartview help folder is the parent folder of the
language folders. Thus, you would modify the parent_language_folder_path
placeholder as follows:

<helpurlcontext>file:///C:/Oracle/SmartView/smartview help/</
helpurlcontext>
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» Ifinstalling on a web server, provide the path to the folder that is parent to
the language folders using the following syntax:

<helpurlcontext>http://webServerHost:webServerPort/
pathToHelpFiles/smartview help/</helpurlcontext>

Tip:

Use forward slashes in the syntax and ensure that you enter a
final forward slash (/) after the parent language folder path that
you provide.

Using the example from step 2 and substituting user documentation for
pathToHelpFiles, after extracting the zip contents to http://
abcxyzco.com:12345/user _documentation, the smartview help folder is
the parent folder of the language folders. For example:

<helpurlcontext>http://abcxyzco.com:12345/user documentation/
smartview help/</helpurlcontext>

4. Restart your Microsoft Office applications and access the help from the Smart
View ribbon.

5. Repeat this procedure for each computer that requires Smart View local help.

Optional Local Help Configuration via the Shared
Connections XML File

In a new installation, Oracle Smart View for Office help is available as soon as you
start Excel. You do not need to be connected to a Smart View provider in order to view
the help. After making the changes to the properties.xml file described in this
chapter, help is accessed from the help location you indicate.

If you are also planning to access shared connections from an XML file (as described
in Accessing Shared Connections from an XML File), AND you require an alternative
location for the help, note the following:

* You can add the <helpurlcontext> tag to the shared connections XML file. The
help location you specify in the shared connections XML file overrides the help
location specified in properties.xml once you click the Shared Connections
button in the Smart View Panel. This is true whether or not you modify the
<helpurlcontext>tag in properties.xml.

* If you do not add or specify the <helpurlcontext> tag to the shared connections
XML file, then the local help defined in the properties.xml file will ALWAYS be
used and is available as soon as you start Excel.
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Tips and Troubleshooting
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Related Topics

Diagnostics Tools and Health Check

Installation and Languages

Windows, Office, and Smart View Locale Settings

Installing in the Windows Program Files Folder

Windows Registry Access Requirement for Smart View Installation
Two Smart View Instances Appear in Program and Features Window
Office .NET Installation Option Requirement

Microsoft Office 365 ProPlus Support

Smart View cfg Folder and Properties File Access Requirement
VBA Function Error for Oracle Analytics Cloud or Oracle Bl EE
Failure Connecting to Oracle Analytics Cloud

Ribbons Not Selectable After Installation

Ribbon Display Issue After Connecting to Both Smart View and PowerPivot

Office Unknown Exception Error on a Protected Sheet

Spreading Issue, Smart View Installation, and HsSpread.dll

Smart View Ribbon Fails to Display After Non-Admin Installation
Smart View Display and Operations Issues After Windows 10 Update
Error When First Launching Excel After Installing Smart View

Issues When Starting Excel in Automation Mode

Diagnosing Login Issues

Failure to Establish Connection with Integrated Windows Single Signon
Clearing Smart View Cookies

Problem Opening Files in Excel

Enabling and Disabling Smart View and Other Office Add-ins
Disabling the Smart View Add-on in Apps Other than Excel

Errors when Launching Office after Installing Smart View

Extension Installation from EPM Cloud and Message Window Focus
Extension Updates and Office Applications Remaining Open
Slowness with Extension Options Dialog Box

Office Slow to Start when Internet Connectivity is Not Available

Excel Process Stops Responding (Hangs) on Shut Down
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e Add-ins Menu Still Displays After Smart View Uninstall

* Renaming or Deleting the Excelnn.xIb File

» Extension Updates and Outlook

* Enabling the Smart View Extension for Firefox

* Uninstallation Process Stops Responding

*  Excel Looks for HsTbar.xla File After Uninstall

»  Connection Error

» Bindows Error When Importing Financial Reporting Documents

*  Working with Custom HTML-based Login Forms

» Enable WebView2 to Prevent Script Error on Launching Certain Dialogs
»  Drill-through with Chrome: Blocklist and Allowlist for Native Messaging
*  Browser Settings When Working with XML Files on HTTP Server

*  Flickering Issues on Office 2013 and Office 2016

*  Smart View HTTP Session Timeout

e Third-Party Monitoring Tools May Impact Smart View Stability

*  Duplicate Queries in Word Slow to Refresh

e Custom Styles and Merged Cells in Forms

»  Fixing Function Links on Machines where Smart View was Reinstalled in a User-
specified Location

*  Session Timeout when Connected Using Vanity URLS

e Memory Error on Large Queries

* Issues with Dynamic Data Exchange Option in Excel

* Performance and Memory Usage Considerations for Smart View with Excel
* Unbalanced Loads in Provider Services Clustered Environments

*  Two-Way SSL and Problematic Certificates

Diagnostics Tools and Health Check

ORACLE

Diagnostic Tools

Health Check

Diagnostic Tools

When an issue arises while using Oracle Smart View for Office that you cannot resolve
on your own, use the Smart View Diagnostic tools to create and collect log files and
screenshots to send to Oracle Support. When you are finished collecting diagnostic
data, you use the diagnostic tools to zip up the files. Then you transmit the ZIP file to
Oracle Support for analysis. The log files and screenshots are used by Oracle Support
to troubleshoot and resolve your issue.

The Smart View Diagnostic tools are located in the Diagnostics group in the Smart
View ribbon. You enable the display of the tools by
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You can customize certain features of Smart View Diagnostic tools; for example:

* Hide data values in an Office document.

* Hide member names in an Office document.

» Direct the diagnostics output files to a folder other than the default.

» Allow automatic screenshots for each warning or error message that is displayed.
See Smart View Diagnostics and Health Check in the Oracle Smart View for Office User's
Guide for more information on the Diagnostics tools.

Health Check

You can perform a "health check" on your system to optimize performance and to get
information about your machine, Microsoft Office version, Smart View version, and the
extensions you have installed.

You can view the following information about your system:

*  Version Information—Operating System, Excel Version, Smart View Version
* Hardware Information—RAM Memory, Processor, Smart View Installed Drive Space
» Excel Add-ins—Depends on the Excel add-ins that are installed
* COM Add-ins—Depends on the COM add-ins that are installed
You can make the following changes to system settings and Smart View options:
* Registry Information

— KeepAlive Timeout

— Receive Timeout

— Serverinfo Timeout
*  Smart View Options

— Undo Buffer

— Improve Metadata Storage
*  Graphic Setting

— Disable Windows Transitions on Addin Task Panes

— Disable Animations

For more information, see "Performing a Health Check On Your System" in the Oracle Smart
View for Office User's Guide.

Installation and Languages

ORACLE

The Oracle Smart View for Office installer uses the language set in the Format field of the
Windows Region and Language dialog box, Formats tab. This language also becomes the
default language when running Smart View.

After installation, anytime you change the Smart View language setting (Options dialog box,
Advanced tab), Smart View remembers the new setting on each subsequent launch of Excel.

To return Smart View to the default language, you can use either of the following methods in
the Options dialog box, Advanced tab:
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e Click the Reset button.

» Select the first option in the Language drop-down list. This is always Default,
which is the language specified in the Region and Language dialog box,
Formats tab

After uninstalling and then reinstalling, Smart View reverts to the language specified in
the Windows Region and Language dialog box, Formats tab, and not the last
language specified in the Smart View Options dialog box, Advanced tab.

Office, and Smart View Locale Settings

On each Oracle Smart View for Office client machine, the following locale settings
should match:

*  Smart View language option
*  Microsoft Office language

*  Windows Regional Settings
*  Windows operating system

Running Smart View in a language other than the language of the machine's Windows
operating system, system locale, or Office language, may result in incorrect data being
returned. For example, if the Windows operating system, system locale, and Office
language are English, and you run Smart View in Russian, reports or chart data may
display incorrectly.

Installing in the Windows Program Files Folder

On Windows operating systems, such as Windows 10, non-administrator users are not
authorized to modify the Program Files folder or the Program Files (x86).If an
administrator installs Oracle Smart View for Office in Program Files Or Program Files
(x86), a non-admin user will not be able to uninstall Smart View.

The default installation folder for Smart View is C:\Oracle\SmartView.

Oracle advises that you do not install in Smart View in the Program Files Or Program
Files (x86) folder.

Windows Registry Access Requirement for Smart View
Installation

ORACLE

The Oracle Smart View for Office installation writes to the Windows Registry.
In order for Smart View to write to the Registry, the following is required:

e The user account from which Smart View is installed must have permission to
write to the Windows Registry.

e The "Run as administrator" option is used when installing Smart View.

If a user without the appropriate permissions to the Registry installs Smart View,
issues can arise with some Smart View operations, such as drill-through.
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Two Smart View Instances Appear in Program and Features

Window

After an install or upgrade, two instances of Oracle Smart View for Office appear in the
Program and Features window. This occurs when mixing modes (wizard versus silent
install) of install, upgrade, and uninstall.

Smart View allows you to install using a wizard, command line, or silent install. Whichever
method you choose, you must use the same method to upgrade or uninstall. Mixing methods
can result in two instances of Smart View being listed in the Program and Features window
(also referred to as the Add/IRemove Programs window.

To install and upgrade using the wizard, see Installing from My Oracle Support or Oracle
Technical Resources. To uninstall using the the wizard, see Uninstalling Smart View.

To install, upgrade, and uninstall using the command line or silent installer, see Running
Command Line or Silent Installations.

Office .NET Installation Option Requirement

During Microsoft Office installation, you must enable the .NET installation option. When
enabled, files are placed in your Office installation that support interoperability between Office
and other programs and add-ins, such as Oracle Smart View for Office and Smart View
extensions.

Smart View works with these Office interop files:
e Microsoft.Office.Interop.Excel

* Microsoft.Office.Interop.Powerpoint

e Microsoft.Office.Interop.Word

* Microsoft.Office.Interop.Outlook

If these files are not installed, Smart View does not behave as expected. For example, when
connected to Narrative Reporting, you may see a blank report package panel, resulting in an
exception error when clicking in your Office application. Additionally, in the Smart View log
file, you will get errors for an Office interop file; for example:

System.IO.FileNotFoundException: Could not load file or assembly
'"Microsoft.Office.Interop.PowerPoint
Could not load file or assembly 'Microsoft.Office.Interop.PowerPoint

If you see errors in the Smart View log file such as the one shown above, reinstall Office and
ensure that the .NET option is enabled.

Microsoft Office 365 ProPlus Support

ORACLE

A known issue with Microsoft Office 365 ProPlus patch 16.0.10228.20051, updated through
the insider slow channel, prevents users from accessing Oracle Smart View for Office with
Office 365, resulting in the "Member not found" message being displayed. This Microsoft
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patch was pushed to users who signed up for monthly channel updates between June
12 and June 14, 2018.

Workaround: Update Office with Microsoft Office 365 Version 1806 (Build
10228.20080), which contains the fix for this issue.

Smart View cfg Folder and Properties File Access
Requirement

Oracle Smart View for Office requires Write access to the <Smart View Install>/cfg
folder, properties.xml file during runtime. An "Access Denied" error may occur if
users do not have permission to write to this folder or file when attempting the
following operations:

» Saving a file to EPM Cloud using the Save or Save As commands in the Smart
View ribbon

» Performing ad hoc analysis

VBA Function Error for Oracle Analytics Cloud or Oracle Bl

EE

28791548 -- After uninstalling and reinstalling Oracle Smart View for Office, the
following error was displaying when using a VBA function for Oracle Analytics Cloud or
Oracle Business Intelligence Enterprise Edition:

Error '-2147024894(800700002)"': Automation error The system cannot find
the file specified.

In some cases, when Smart View is installed as administrator, the uninstall and
reinstall does not handle registration of the Oracle Bl EE extension file correctly.

To remedy this issue, after installation, and before starting Office, install the Oracle Bl
EE extension manually:

1. After uninistalling and reinstalling Smart View, ensure that all Office applications
remain closed.

2. Navigate to C:\Oracle\SmartView\extensions and double-click on
JBIPSProviderInstaller.svext.

3. Inthe message that indicates successful installation, click OK.

The Oracle Bl EE extension installation is complete and you may start Office.

Failure Connecting to Oracle Analytics Cloud

ORACLE

Issue

In some cases, in an Oracle Analytics Cloud production environment, users may have
issues connecting to Oracle Analytics Cloud from their Oracle Smart View for Office
installation.

This is the type of scenario where this situation can occur:
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* Users connect to Oracle Analytics Cloud via VPN

»  Oracle Analytics Cloud is protected by Oracle Identity Cloud Service, which is requested
through an Internet Proxy

» Oracle Identity Cloud Service is integrated with a federated single-signon system, such
as Ping Identity

» Users on two different domains install Smart View via a package, delivered using
Microsoft Application Virtualization (Microsoft App-V)

When trying to connect, an empty login screen pops up repeatedly, and then the login finally
fails. This can happen when pasting a connection URL in the Private Connection Panel.

Cause

The root cause for this issue is that the Smart View packaged version, prior to login, opened
a browser process named ielowutil.exe. The non-packaged local install of Smart View, or
packaged install with Micorosoft Internet Explorer already running, both launched
iexplore.exe instead.

The ielowutil.exe file is a special protected version of Internet Explorer named "Low MIC
[Medium Integrity Cookie] Utility.” It prevents the sharing of cookie data between processes of
differing integrity.

This can explain why login to Oracle Analytics Cloud likely fails — since it requires cookie
information that is set by both Oracle Identity Cloud Service and Ping Identity, and continues
to assume the user is not logged in — redirecting back to Oracle Identity Cloud Service in a
loop that escapes only after 12 times.

" Note:

Microsoft discontinued support for Internet Explorer on June 15, 2022. Howevet,
you should not uninstall Internet Explorer. For more information, see Internet
Explorer 11 End of Support and Smart View.

Solution

Using Process Monitor (Windows Sysinternals), the registry key used to read the browser
was different in each case and was identified as followed:

*  Working Key:

HKEY CLASSES ROOT\Wow6432Node\CLSID\{0002DF01-0000-0000-C000-000000000046}\
(Default)

Presents the value:
Internet Explorer (Ver 1.0)
*  Non-working Key:

HKEY CLASSES ROOT\Wow6432Node\CLSID\{0002DF01-0000-0000-
C000-000000000046}\LocalServer32\ (Default)

Presents the value:

"$ProgramFiles (x86) $\Internet Explorer\ielowutil.exe" -CLSID:
{0002DF01-0000-0000-C000-000000000046}

6-7



Chapter 6
Ribbons Not Selectable After Installation

The registry key:

HKEY_CLASSES_ROOT\WOW6432Node\CLSID\{OOOZDFOI—OOOO—OOOO—
C000-000000000046}\LocalServer32\ (Default)

is a pointer to:

HKEY LOCAL MACHINE\SOFTWARE\Classes\Wow6432Node\CLSID\{0002DF01-0000-0000-
C000-000000000046}\LocalServer32\ (Default)

Changing this key to a new value of:

"$ProgramFiles (x86)%\Internet Explorer\iexplore.exe"

results in the Smart View package calling iexplore.exe instead, and the login
succeeding.

All registry checks and changes must be done in the same App-V Package/Version ID
environment as the Smart View package, ensuring that the local system is left intact;
that is:

regedit /appvve:307790F2-DE31-4EBE-B3BC-4C9337032E73 0BE1C6E6-85CC-48C3-
AQFF-3BBB789681C3

Since users generally do not have admin access, you may roll out the fix to
HKEY CURRENT USER by adding the key to the same path:

HKEY CURRENT USER\Software\Classes\Wow6432Node\CLSID\{0002DF01-0000-0000-
C000-000000000046}\LocalServer32\ (Default)

In the case of different Smart View packaged versions (some in an App-V connection
group) across different domains, a PowerShell script can been written to identify the
Smart View packages and make the correct registry changes.

Testing, this key change should result in Smart View users being able to successfully
and consistently log in to Oracle Analytics Cloud.

Ribbons Not Selectable After Installation

On Windows 10 and 11, after installing Oracle Smart View for Office and starting Excel
for the first time, you are not able to select any other Excel ribbons or the Smart View
ribbon, or select any menu items on the default Home ribbon.

Workaround: Click the X in the top right corner to close Excel, and then restart Excel.
Now you should be able to select the Smart View ribbon and any other Excel ribbon.

Ribbon Display Issue After Connecting to Both Smart View
and PowerPivot

ORACLE

If you are connected to Oracle Smart View for Office and Microsoft PowerPivot at the
same time, and then close Excel and reopen Excel, both the Smart View and
PowerPivot ribbons are missing from Excel.

Workaround: Terminate the Excel process in Windows Task Manager, then reopen
Excel.
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Office Unknown Exception Error on a Protected Sheet

Upon opening a password-protected worksheet, an exception is thrown as Oracle Smart View
for Office tries to set Range.ID, required for duplicate (non-uniqgue) member name support.
An exception is also thrown by the Excel APl on any operation that requires Smart View to
write into worksheet if the worksheet is password protected.

Note that Smart View does not work with password-protected worksheets.
If possible, try the following workarounds:

* Remove password protection.

* Rewrite macros in a way that prevents Smart View from trying to write in password-
protected worksheets.

Spreading Issue, Smart View Installation, and HsSpread.dll

ORACLE

In some cases, spreading is not working as expected.

Oracle Smart View for Office is not automatically spreading data from the YearTotal or
Quarter level down to the months. Data is spread automatically when entering values into
forms on the web, but the same functionality is not working in Smart View.

The issue may be due to the dynamic link library, HsSpread.d11, not being registered
correctly, which can happen when Smart View is installed by a non-admin user.

This issue affects Planning 18.02.67+ and Planning Modules 17.12.54 and later.
To fix this issue, Oracle recommends the following:

« Uninstall Smart View and reinstall as the Windows administrator. See Reinstall Smart
View as Administrator.

e If the spreading issue persists after reinstalling Smart View as the administrator, then
manually register the HsSpread.d11 file. See Register HsSpread.dll.

Reinstall Smart View as Administrator
To reinstall Smart View as administrator, perform these steps:
1. Uninstall Smart View.

See Uninstalling Smart View for more information.

2. Reinstall Smart View by right-clicking Smartview.exe and selecting Run as
administrator.

See Installing from My Oracle Support or Oracle Technical Resources for more
information.

3. Launch Excel, open a form or ad hoc grid, and verify that spreading is working.
If the spreading issue persists, complete the steps in Register HsSpread.dlIl.

Register HsSpread.dll

To register the HsSpread.d11 with Windows:

1. Start a Windows command prompt as administrator.
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2. Switch to the bin folder in your Smart View installation.
The default location is Oracle\SmartView\bin.

3. Run the following command:

C:\Windows\Microsoft .NET\Framework\v4.0.30319\regasm.exe /codebase
HsSpread.dll

4. In the command prompt, check for any errors in the output.
5. Test the spreading functionality.

If the issue persists, contact Oracle Support.

Smart View Ribbon Fails to Display After Non-Admin
Installation

ORACLE

In some cases, installing Oracle Smart View for Office on Windows 10 or 11 as a non-
admin can cause the Smart View ribbon to fail to display.

In a non-admin install, you double-click the smartvView.exe file to launch the installer.
In an admin install, you right-click Smartview.exe and select Run as administrator.

If you installed Smart View as a nhon-admin and the Smart View ribbon does not
display, complete the following procedures to troubleshoot this issue:

Add the COM Add-in

Reinstall Smart View as Administrator

Add the COM Add-in
To add the Smart View COM add-in:

1. In Excel, select File, then Options, and then Add-ins.
2. From Manage, select COM Add-ins, and then click Go.

3. In COM Add-ins, select the check box to enable the Oracle Smart View for
Office add-in, and click OK.

4. Restart Excel.
If the Smart View ribbon does not display after restarting Excel, proceed to
Reinstall Smart View as Administrator.

Reinstall Smart View as Administrator

If the Smart View ribbon still fails to display after adding the COM add-in, perform
these steps:

1. Uninstall Smart View.
See Uninstalling Smart View for more information.

2. Reinstall Smart View by right-clicking SmartView.exe and selecting Run as
administrator.

See Installing from My Oracle Support or Oracle Technical Resources for more
information.

3. Launch Excel and verify that the Smart View ribbon is displayed.
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Smart View Display and Operations Issues After Windows 10

Update

After a Windows 10 update on some high-resolution displays, drag-and-drop may not work as
expected, some controls may look blurry, and some operations may not work properly. For
example, an "Invalid selection” error occurs when trying to drag and drop members from the
POV.

To avoid the "Invalid selection" error and other display issues after a Windows update:

1. Select the Windows 10 Start button, then Settings, then System, then Display, and
then Advanced scaling settings.

2. Under Fix scaling for apps, set Let Windows try to fix apps so they are not blurry to
on.

3. Restart Excel.

Drag-and-drop and other operations should work as expected, and the display of Oracle
Smart View for Office controls should be improved.

Error When First Launching Excel After Installing Smart View

ORACLE

After installing Oracle Smart View for Office and launching Excel for the first time, you may
get an error message similar to the following: "Unable to set the installed property of the add-
in class."

Workarounds:

» Enable the Smart View Excel add-in using one of the following methods:
— Trust Center Method
— COM Add-ins Method

» If the above methods do not resolve the issue, try reinstalling Smart View as
administrator.

See Reinstall Smart View As Administrator.

Trust Center Method

1. Perform the task appropriate for your Office version:

- 365 Windows client, 2019, 2016, 2013, 2010: Go to File, then Options, and then
Trust Center.

e 2007: Click the Office button in the top left corner of Excel, then select Excel
Options, and then Trust Center.

Click the Trust Center Settings button.
In the left pane, select Trusted Locations.

Click Add new location to launch the Microsoft Office Trusted Location dialog box.

o > w0 D

In Path, enter the path to the Smart View bin folder; for example:
C:\Oracle\SmartView\bin

6. Click OK.
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7. Click OK to close the Trust Center, and then click OK to close Excel Options.

COM Add-ins Method

1. Perform the task appropriate for your Office version:

» 365 Windows client, 2019, 2016, 2013, 2010: Go to File, then Options, and
then Add-ins.

* 2007: Click the Office button in the top left corner of Excel, then select Excel
Options, and then Add-ins.

2. From Manage, select COM Add-ins, and then Go.

3. In COM Add-ins, select the check box to enable the Oracle Smart View for
Office add-in, and click OK.

Issues When Starting Excel in Automation Mode

ORACLE

In some cases, third-party software that automates Excel processes, such as
exporting to Excel, may cause issues with Excel and a conflict with Oracle Smart View
for Office.

Workaround:

To disable Smart View when Excel is started in automation mode, you may enable
"DisablelnAutomation” by adding a key and key value to the Windows Registry. To do
this, create the Options key and DisablelnAutomation key value as follows:

* Key Name:
[HKEY CURRENT USER\Software\Oracle\SmartView\Options]
* Key Value:

"DisableInAutomation"=dword:00000001

When set to 00000001, Smart View is disabled when Excel is started in automation
mode. Smart View starts correctly when Excel is started manually, outside of an
automated process.

When set to 0 or not created at all, then Smart View is enabled and starts when
Excel is started in automation mode, which may cause issues. Smart View starts
correctly when Excel is started manually, outside of an automated process.

Creating the Registry Key and Key Value
To create and update the registry key, Options:
1. Click Start, click Run, type regeditin the Open box, and then click OK.

2. Locate and then select the following registry subkey:
HKEY CURRENT USER\Software\Oracle\SmartView\

3. From the Edit menu, select New, and then select Key.

4. Type Options, and then press Enter.
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5. From the Edit menu, select New, and then select DWORD Value.

6. Type DisableInAutomation, and then press Enter.

7. Inthe Details pane, right-click DisablelInAutomation, and then click Modify.
8. Inthe Value data box, type 00000001, and then click OK.

The value, 00000001, enables the DisablelInAutomation key.
# Note:
If a zero value is entered, then this option is disabled.

9. Exit Registry Editor.
10. Restart Excel.

Diagnosing Login Issues

ORACLE

Related Topics
 Smart View Does Not Connect to a Data Source

* Attempts to Connect to the Server Fail in SSO-Enabled Environments

Smart View Does Not Connect to a Data Source

Oracle Smart View for Office fails to establish a connection with a data source primarily
because of errors in the shared or private connection URL that is being used. For information
on connection types, see Shared Connections and Private Connections in Oracle Smart View
for Office User's Guide.

»  Verify that the connection URL syntax and the credentials being used are accurate.
Consult your Smart View administrator to verify:
— The shared or private connection URL you are using is correct
— You have a valid user name and password to access the connection

» Using a browser, access the environment that supports the data source. Make sure that
you can log in using the credentials that you are using to access the data source through
Smart View.

For example, if you are attempting to connect to an EPM Cloud data source, launch a
browser and enter the connection URL for the web business process. In the signon
screen, enter the user name and password you would use to access that business
process as a connection in Smart View. Consult your Smart View administrator if you
need help forming the URL or if you do know the user name and password that you
would use to access the connection in Smart View.

» If the issue persists, seek Oracle's help using the steps detailed in Getting Help in the
Oracle Enterprise Performance Management Cloud Operations Guide.

Attempts to Connect to the Server Fail in SSO-Enabled Environments

Smart View fails to establish a connection to an Oracle Enterprise Performance Management
Cloud environment that is configured for SSO and displays the following error:
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Oracle Smart View for Office »

Cannot connect to provider. The attempt to connect to the server
failed. Make sure the server is running in the specified URL,

This error is displayed if you previously selected the Remember my choice option in
a browser while signing into an EPM Cloud environment using the Company Sign In

button.
Welcome change domain ':::.:'
Want to use your company account?
Use to be redirected to the company single sign-on
Cant access your account? Company Sign In
Sign In ] Remember my choice o

To resolve this issue, complete this procedure:
1. Close Microsoft Excel.

2. Delete browsing history, temporary internet files, cookies and site data, and form
data.

You can use browser-specific procedures for deleting the above items.
Additionally, you can complete the procedure in Clearing Smart View Cookies.

3. Open Excel and sign into Smart View.

Failure to Establish Connection with Integrated Windows
Single Signon

When Oracle Enterprise Performance Management Cloud is configured to use
Windows single signon with Microsoft Azure AD, attempts to establish connection to
EPM Cloud using a shared connection can fail and you may see this error message:

The provider running at <serviceURL>/workspace/SmartViewProviders is not a
Shared Services provider.

Using a private connection, the message reads:
Unable to connect to the provider.

This error is related to Oracle single signon setup, and occurs when users are already
logged in to their Microsoft Azure AD account (also known as Microsoft Entra ID).

Workarounds: To resolve this error, try either of the following workarounds:
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Enable "Chooser login page" during Fusion SSO setup. Once enabled, users are brought
to the chooser login page and they are able to connect by clicking Company Sign On.

If the "Chooser login page" is not enabled, then add full URLs, including Oracle Smart
View for Office shared or private connection URLS, to the secure site list in Windows
Internet Options.

Be sure to add all URLs that are used during authentication.

# Note:

Administrators should perform a trace to assist in collecting the URLs of all the
sites involved in authentication. For example, there should be "oraclecloud"
sites for production, possibly a test site, as well as Azure AD sites, along with
the Smart View connection URLSs.

Do not use an asterisk (*) to abbreviate URLSs, for example, do not use

* oraclecloud.com. You must always use the full URL.

To add URLSs, including Smart View connection URLS, as secure, or trusted sites, in the
Windows Control Panel, go to Internet Options, then select the Security tab, then select
Trusted Sites, and then click the Sites button. Enter the full URL and click Add. Repeat
for all required authentication and connection URLS.

Some Smart View connection URL syntax examples follow:

— Shared connection:
https://<serviceURL>/workspace/SmartViewProviders

— Private connection:
https://<serviceURL>/HyperionPlanning/SmartView

See Creating Shared Connections and Creating Private Connections in the Oracle Smart
View User's Guide for more information on data source connection syntax.

Clearing Smart View Cookies

Occasionally, you may need to clear Oracle Smart View for Office cookies.

ORACLE

For example, after using the Disconnect All command and restarting Smart View, you may
find that you're not prompted to log in.. Clearing cookies will clear the browser cache and
facilitate the signoff and subsequent login.

To clear Smart View cookies:

1.
2.

Close all Office applications.

Use either method to launch the Microsoft Windows Internet Options dialog:
e In a Windows Command Prompt, enter inetcpl.cpl

e From the Windows Control Panel, select Internet Options.

The Internet Options dialog is displayed.

In the General tab, click the Settings button.

The Website Data Settings dialog is displayed.
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Optional: In the Temporary Internet Files tab, under Check for hewer versions
of stored pages, select Every time | visit the webpage.

In the Temporary Internet Files tab, click the View files button.

A File Explorer window displays the contents of this folder:
C:\User\<user>\AppData\Local\Microsoft\Windows\INetCache

Delete the contents of the AppData\Local\Microsoft\Windows\INetCache folder.

Click OK to exit the Website Data Settings dialog, and then click OK to exit the
Internet Properties dialog.

Restart Office, select a data provider, and provide your login credentials when
prompted.

Problem Opening Files in Excel

Sometimes, temporary files and folders stored in the
C:\Users\UserName\AppData\Roaming\Microsoft\Excel folder can cause issues
when trying to open a workbook file in Excel. You can back up the contents of this
folder and then clear the folder to improve performance when opening a workbook.

To improve Excel performance when opening a workbook:

1.

ORACLE

Close all applications and restart your computer once.

This is to ensure that there are no hidden instances of Excel running in the
background.

After the reboot, create a folder on your computer (for example, in the besktop or
the Documents folder) and give is a descriptive name (for example, Excel AppData
Backup).

Open Windows File Explorer, then select the View menu, and then select the
check box to show Hidden items.

Navigate to:

C:\Users\User Name\AppData\Roaming\Microsoft\Excel

Replace User Name with your Windows login user name.

Use Windows Cut and Paste to move all the files and folders from the directory
you created in the previous step to the backup folder that you created in step 2.

The C:\Users\User Name\AppData\Roaming\Microsoft\Excel folder should be
empty.

In File Explorer, go to the View menu and clear the Hidden items check box.
Close File Explorer, and then start Excel.

Try opening the files that you were having problems opening earlier.
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Enabling and Disabling Smart View and Other Office Add-ins

You can enable and disable Oracle Smart View for Office and other Microsoft Office add-ins
from the Add-Ins tab in Excel Options. In some cases, Smart View performance can be
improved when other Office add-ins are disabled.

ORACLE

To enable or disable Smart View or other Office add-ins for all applicable Office applications
(including Outlook):

1.

Open Excel, Word or PowerPoint.
Do not use Outlook to enable and disable Office add-ins.
Go to File, then Options, and then Add-Ins.

Continue with step 3 to work with COM Add-ins. Continue with step 4 to work with Excel
Add-ins.

To enable or disable COM add-ins, from Manage, select COM Add-ins, then click Go
and then perform a task:

* To enable add-ins, ensure that the check box next to the add-in is checked.

If the check box next to the add-in is cleared, then click the check box to select it, and
then click OK.

If the add-in you want to enable is not in the list, click Add, navigate to the location of
the add-in file in your system and select it, then click OK, and then click OK again in
the COM Add-Ins dialog to close it.

* To disable add-ins, ensure that the check box next to the add-in is cleared.

If the check box next to the add-in is checked, then click the check box to clear it, and
then click OK.

In the following example COM Add-Ins dialog box, the Acrobat PDFMaker Office COM
Addin, is disabled; other available add-ins are enabled, including Smart View.

~

COM Add-Tns

Add-Ins available:

W] 2crobat POFMaker Office COM Addin A

Crade Beehive Add-In for Office Cancel
Orade Smart View for Office
Send to Bluetooth

o
e

Remowve

Location: C:\Program Files (x88)\Adobe\Acrobat 2015\PDFMaker \Office \PDFMOfice Addin. dll
Load Behavior: Load at Startup

e

To enable or disable Excel add-ins, from Manage, select Excel Add-ins, then click Go
and then perform a task:

* To enable add-ins, ensure that the check box next to the add-in is checked.

If the check box next to the add-in is cleared, then click the check box to select it, and
then click OK.
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If the add-in you want to enable is not in the list, click Browse, navigate to the
location of the add-in file in your system and select it, then click OK, and then
click OK again in the COM Add-Ins dialog to close it.

» To disable add-ins, ensure that the check box next to the add-in is cleared.

If the check box next to the add-in is checked, then click the check box to clear
it, and then click OK.

In the following example Add-Ins dialog box, the Smart View add-in, Hstbar, is
disabled; other available add-ins are enabled. Note that these add-ins are not
related to Smart View.

Add-Ins

Add-Ins available:

L2

[] Analysis ToolPak - 0K
[¥] Analysis ToolPak - VBA
V] Conditional Sum Wizard
Euro Currency Toals

FE
..... B e
| Internet Assistant VBA SO
¥ | Lookup Wizard i
[¥] solver Add-in
Hstbar

-

5. Restart any open Office applications.

Disabling the Smart View Add-on in Apps Other than Excel

ORACLE

If users plan to work with Oracle Smart View for Office only in Microsoft Excel, and not
with Word, PowerPoint, or Outlook, you can edit Windows Registry keys to prevent
Smart View from loading into the other Office applications.

Before you edit the Registry, ensure that all Office applications are closed and no
Office processes are running in the Task Manager.

To disable loading Smart View into Word, PowerPoint, or Outlook, open the Registry,
navigate to each of the Office applications listed below, and set the LoadBehavior
value for each applications to 0.

Word:

HKEY CURRENT USER\SOFTWARE\Microsoft\Office\Word\Addins\Hyperion.Common
Addin
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PowerPoint:

HKEY CURRENT USER\SOFTWARE\Microsoft\Office\PowerPoint\Addins\Hyperion.Common
Addin

Outlook:

HKEY CURRENT USER\SOFTWARE\Microsoft\Office\Outlook\Addins\Hyperion.CommonAdd
in

When LoadBehavior is set to 0, the respective Office application will not load the specific
add-in.

Restart the affected Office applications and verify that the Smart View ribbon does not
display.

You can disable any or all of the above Office applications, as required.

To switch back to loading the Smart View add-on for specific Office applications, set the
LoadBehavior value for the application to 3. This will cause the Smart View add-on to be
loaded when restarting the Office application.

Errors when Launching Office after Installing Smart View

ORACLE

Two types of errors may occur when launching Oracle Smart View for Office. If you encounter
these errors, use the workarounds noted below.

* Unable to set the installed property of the add-in class
* Add method of AddIns class failed

Unable to set the installed property of the add-in class

After installing Smart View and launching Excel the first time, you may get an error message
similar to the following:

Unable to set the installed property of the add-in class.
If you see this error, enable the Smart View add-in:

1. Open Excel, Word or PowerPoint.
Do not use Outlook to enable and disable Office add-ins.
2. Go to File, then Options, and then Add-Ins.
3. From Manage, select COM Add-ins, then click Go.
4. Ensure that the check box next to Oracle Smart View for Office is checked.

If the check box next to the add-in is cleared, then click the check box to select it, and
then click OK.

If the Oracle Smart View for Office add-in is not in the list, click Add, navigate to the
location of the add-in file in your system (by default,
C:\Oracle\SmartView\bin\HsTbar.xla) and select it, then click OK, and then click OK
again in the COM Add-Ins dialog to close it.

5. Restart Office.
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Add method of Addins class failed
After installing Smart View, the following error occurs each time Excel is launched:
Add method of AddIns class failed.

If you see this message, click OK in the error message box. Excel and Smart View will
then work properly.

Extension Installation from EPM Cloud and Message
Window Focus

ORACLE

Installing extensions from supported Oracle Enterprise Performance Management
Cloud services involves downloading an extension installer file and double-clicking it.
When double-clicking an extension installer (.svext), a message window is displayed
indicating the success or failure of the installation. The message window can
sometimes lose focus and go behind another open window, and can easily go
unnoticed. This may lead to users trying to install the extension again, causing an error
due to the previous open message window having a hold on the folder and files.

To clean up this extension installation issue:
1. Close all Office applications (Excel, Word, PowerPoint, Outlook).
2. Check the Windows task bar for an existing message window, and close it.
3. Remove prior extension installations:
a. Navigate to $AppData%\Oracle\SmartView\extensions\bin
b. Delete the extension folder.

For example, to delete the Narrative Reporting extension folder, delete the
Oracle.SmartView.EPRCSExtension folder.

c. Delete the extension installation folder.

For example, to delete the Narrative Reporting extension installation folder,
delete the EPRCSProviderInstaller folder.

4. Remove pending installations:
a. Navigate to $AppData%\Oracle\SmartView\extensions\update
b. Delete the pending extension installation folder.

For example, to delete the Narrative Reporting pending extension installation
folder, then delete the Oracle.SmartView.EPRCSExtension folder.

5. Return to the location where you previously downloaded the extension installer
file, and double-click it.

For example, to install the Narrative Reporting extension, double-click
EPRCSProviderInstaller.svext.

6. Open Excel, Word, or PowerPoint, and in the Smart View ribbon, click Options,
then select Extensions, and then verify that the extension you installed is listed.
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Extension Updates and Office Applications Remaining Open

In order for extensions to be properly installed, removed, or updated, all Office applications
must be shut down. When an Office application is reopened, updates for extensions are
applied.

Sometimes, even though an Office application has been closed, it does not completely shut
down, or does not shut down in a timely manner. In these cases, an instance of Office is still
running and Oracle Smart View for Office is unable to apply the extension updates correctly.

For these situations, it may be necessary to open the Windows Task Manager and look for
possible Office applications that may still be running. For Windows 10 and 11, select the
Details tab to find the correct process name corresponding to the Office applications.
Application names to look for are:

« EXCEL.EXE

* OUTLOOK.EXE

«  POWERPNT.EXE
*  WINWORD.EXE

If any of these application names are displayed in the Task Manager, click on the name and
end the process.

Once all Office applications are closed, reopen one of the applications so that Smart View
can apply pending updates.

Slowness with Extension Options Dialog Box

When opening the Extensions tab of the Options dialog box or when checking for extension
updates, if your system seems to be taking a long time to complete these tasks, ensure that
the machine has access to the internet.

Office Slow to Start when Internet Connectivity is Not Available

When starting Office, Oracle Smart View for Office performs various security checks at
startup, including checks on all the installed extensions. Internet connectivity is required in
order to perform these checks.

Without internet connectivity, the security checks on extensions cannot be carried out and
Office applications will be very slow to launch.

You may disable extensions in order to improve Office startup time, but you will lose the
functionality related to those extensions, even if you are still able to connect to data providers
through your company's intranet.

Oracle recommends verifying that you can connect to the internet when starting Office with
Smart View installed.

Excel Process Stops Responding (Hangs) on Shut Down

Excel may be slow to shut down if the Excel15.x1b file is corrupted. This file stores changes
to the ribbons in Excel.
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A simple fix to this issue is to rename Excell5.x1b. A clean Excell5.x1b file is rebuilt
the next time you start Excel.

The Excell5.x1b file is located in the
C:\Users\user\AppData\Roaming\Microsoft\Excel folder.

To rename the Excell5.x1b file, see Renaming or Deleting the Excel xx.xlIb File.

Add-ins Menu Still Displays After Smart View Uninstall

When Oracle Smart View for Office is installed, a Smart View ribbon tab is displayed in
Office. This is the expected behavior.

In some cases, after uninstalling Smart View and installing a newer version, an Add-
ins ribbon tab is also displayed next to the Smart View ribbon tab. Moreover, in some
cases, after uninstalling the newer version of Smart View and restarting Excel, the
Smart View ribbon tab is no longer displayed, as expected, but the Add-ins tab
remains.

This issue can be caused by a corrupted Excelnn.x1b file. This file stores changes to
the ribbons in Excel.

You can fix this issue by renaming or deleting the Excelnn.x1b. A clean Excelnn.x1b
file is rebuilt the next time you start Excel.

The Excelnn.x1b file is located in the
C:\Users\user\AppData\Roaming\Microsoft\Excel folder.

To rename the Excelnn.x1b file, see Renaming or Deleting the Excelnn.xIb File.

Renaming or Deleting the Excelnn.xlb File

ORACLE

You may need to rename or delete Excelnn.x1b if it is determined that this file is
causing issues with your Oracle Smart View for Office installation.

Renaming or deleting the existing Excelnn.x1b file causes a new Excelnn.x1b to be
created the next time you start Excel. This usually fixes any issues you may have had
with the previous version of the X1B file.

To rename or delete the Excelnn.x1b file:

1. Close any open Excel applications and ensure that all excel.exe processes in the
Windows Task Manager are ended.

2. Locate the Excelnn.x1b file in your AppData folder.

For example, the default location of the Excelnn.x1b file is:
C:\Users\user\AppData\Roaming\Microsoft\Excel

Tip:

You can quickly navigate to this folder by entering %appdata%
\Microsoft\Excel in the address bar of Windows Explorer.

3. Right-click the Excelnn.x1b file name, then perform either of these tasks:
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* Select Rename, then enter a new name for the file, and then press Enter.
For example, append .old to the file name:
Excellb5.xlb.old
* Select Delete.
4. Restart Excel.

A clean Excelnn.x1b file is created in the
C:\Users\user\AppData\Roaming\Microsoft\Excel folder.

Extension Updates and Outlook

ORACLE

When applying extension updates, if any Office application is running, including Outlook, a
message directs the user to close all Office applications. This includes Outlook, as well as
Excel, Word, and PowerPoint.

If the message in Figure 1 is displayed after attempting an extension update, it means that
one of the Office applications was not closed. Often, the application left open is Outlook.

Figure 6-1 Message - Office Application Open During Extension Update

Oracle Smart View for Office >

An extension that is flagged for removal is currently in use in folder:
e C\Users' I AppDatat Reamingh Oracleh SmartView', Exte

nsicns\BintOracle. SmartView EPRCSExtension

Check if folder is open and close ALL Office Applications to release files,

Then recpen Office Application to allow Smart View to run removals

and updates,

Mote that this may affect additional updates during this session,

Exception: Access to the path 'EPRCSProvider.dll' is denied.

OK

If Smart View is not needed for Outlook, it can be disabled to help avoid this issue during
extension updates.

To disable Oracle Smart View for Office in Outlook:
1. In Outlook, go to the Smart View ribbon, then select Options, and then select Advanced.
2. Under Display, select the Disable Smart View in Outlook check box.
3. Click OK, and then close Outlook.
4. Restart Outlook.
Verify that the Smart View ribbon no longer appears.

5. Start a different Office application to continue the extension update process.
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Enabling the Smart View Extension for Firefox

During installation, Oracle Smart View for Office automatically installs an extension for
Mozilla Firefox.

If you specify Firefox as your default browser, Smart View utilizes the extension for
Firefox in these scenarios:

e Performing drill-through in Smart View

e Launching forms in Smart View from browser-based applications, such as Oracle
Hyperion Financial Management or the Planning business module in Oracle
Enterprise Performance Management Cloud.

The extension for Firefox is automatically enabled after installing Smart View.
However, if the extension should become disabled, follow the procedure in this topic to
enable it again.

To enable the Smart View extension for Firefox:

1. In Firefox, in the upper right corner of the browser, click = | and then select
Add-ons from the drop-down menu:

&

Add-ons

2. Inthe left pane, select Extensions, and then scan or search the list to locate the
Oracle Smart View Office entry.

Enable

3. Click Enable, and restart Firefox.

You can restart Firefox immediately using the Restart now link, or restart Firefox
at your convenience.

v Oracle Smart View for Office will be enabled after you restart Firefos Restart now Undo
Oracle Smart View for Office (disabled)

Launch MS Office applications with Oracle Smart View content. More

Disable

Uninstallation Process Stops Responding

On supported Windows platforms, the Oracle Smart View for Office uninstallation
process may stop responding.
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If you have experienced this issue, try the following:

1.

In the Windows Task Manager, kill all occurrences of these processes:
» Microsoft Register Server
*  Windows Installer

In the Control Panel, check Programs and Features to verify if Oracle Smart View for
Office is listed.

If Oracle Smart View for Office is not listed, then the uninstallation completed
successfully.

If Oracle Smart View for Office is listed, select it, and then select Uninstall to try the
uninstallation again.

Excel Looks for HsTbar.xla File After Uninstall

Sometimes, after uninstalling Oracle Smart View for Office and subsequently launching
Excel, Excel may still try to locate the Smart View HsTbar.x1a file.

ORACLE

To correct this, you must edit the Windows Registry.

To edit the Windows Registry to keep Excel from looking for HsTbar . x1a file after uninstalling

Smart View:
1. Open the Windows Registry Editor (enter regedit in a command window).
2. Locate this key:
HKEY CURRENT USER\Software\Microsoft\Office\<OfficeVersion>\Excel\Options
3. Delete the 0PEN or OPEN<n> entry where the value in the Data column contains

HsTbar.xla.

For example:

C:\Oracle\SmartView\bin\HsTbar.xla

When there are multiple OPEN entries, perform these steps:

a. Delete all 0PEN entries where the Data column value contains HsTbar.x1a.
b. Rename all remaining OPEN<n> entries, maintaining their sequential values.

For example, here are six OPEN entries, where two of the entries, OPEN and OPEN4,
contain HsTbar.x1la in the Data column.

Name Value in Data Column
OPEN Contains HsTbar.xla
OPEN1 Does not contain HsTbar.xla
OPEN2 Does not contain HsTbar.xla
OPEN3 Does not contain HsTbar.xla
OPEN4 Contains HsTbar.xla
OPENS Does not contain HsTbar.xla

Delete the oPEN and 0PEN4 entries, and then rename the remaining entries as follows,

maintaining their sequential order:

¢ Rename OPEN1 to OPEN
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¢ Rename OPEN2 to OPEN1
¢ Rename OPEN3 to OPEN2
¢ Rename OPEN5 to OPEN3

The remaining entries are:

Name Value in Data Column
OPEN Does not contain HsTbar.xla
OPEN1 Does not contain HsTbar.xla

OPEN2 Does not contain HsTbar.xla
OPEN3 Does not contain HsTbar.xla

Connection Error

Oracle Smart View for Office may fail to connect to Planning or Planning Modules with
the script error,

An HTTP error occurred with the code "-1"

The workaround is to set the Browser Emulation Mode option in the Health Check
dialog; for example, set this option to 11001 for Microsoft Internet Explorer 11
compatibility.

For more information on the Browser Emulation Mode option in the Health Check
dialog, see Performing a Health Check on Your System in the Oracle Smart View for
Office User's Guide.

¢ Note:

Microsoft discontinued support for Internet Explorer on June 15, 2022.
However, you should not uninstall Internet Explorer. For more information,
see Internet Explorer 11 End of Support and Smart View.

Bindows Error When Importing Financial Reporting
Documents

ORACLE

When connected to Oracle Enterprise Performance Management Cloud 22.08+, a
Bindows error can occur when importing Oracle Hyperion Financial Reporting
documents.

Workaround: To avoid this error, in the Health Check dialog, change either the
Browser Emulation Mode setting or the WebView2 Runtime setting, or both:

1. From the Smart View ribbon in Excel, click the arrow next to Help, and then select
Health Check to launch the Health Check dialog.

2. In the Registry Information group, locate the Browser Emulation Mode line,
then:

a. In the Fix/lUpdate/Info column, click in the cell to enable the drop-down list,
and select 11001.
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b. Click the Update Settings button.
3. Inthe Smart View Options group, locate the WebView2 Runtime line, then:

a. In the Fix/Update/lnfo column, click in the cell to enable the drop-down list, and
select Enable for All.

b. Click the Update Settings button.

4. Click Close, then restart Excel, connect to the data source, and import a Financial
Reporting document.

Working with Custom HTML-based Login Forms

If you are using a custom HTML-based login form instead of the default Oracle Access
Manager login form, ensure that the source of the custom form includes the string loginform.
This is required for Oracle Smart View for Office integration with Oracle Access Manager to
work.

Enable WebView2 to Prevent Script Error on Launching Certain

Dialogs

When attempting to launch certain dialogs, the Script Error dialog is displayed if WebView2
is disabled; for example, you launch the Instructions dialog, and the instructions area is
blank and the Script Error dialog is displayed.

Workaround: In the Health Check dialog, ensure that WebView2 Runtime is installed and
select Enable for Ul, described in Performing a Health Check On Your System in the Oracle
Smart View for Office User's Guide.

Drill-through with Chrome: Blocklist and Allowlist for Native
Messaging

ORACLE

Drill-through with a Google Chrome browser can fail when Chrome is managed by enterprise
policy. In this case, native messaging applications can use a blocklist or an allowlist. For
example, if an administrator restricts access to all messaging hosts by using a blocklist (by
specifying "*" in the blocklist registry key), then drill-through from Oracle Smart View for
Office would not work with Chrome.

In order to enable the Smart View native application which supports the Chrome extension
(the application is C:\Oracle\SmartView\bin\SVNatvMsg.exe), then an administrator must
add the name of the application, com.oracle.smartview.nmh (as specified in
C:\Oracle\SmartView\bin\chromenmh.json) to the allowlist registry key.
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< Note:

e Creating a blocklist is described here:

https://cloud.google.com/docs/chrome-enterprise/policies/?
policy=NativeMessagingBlocklist

e Creating an allowlist is described here:

https://cloud.google.com/docs/chrome-enterprise/policies/?
policy=NativeMessagingAllowlist

Browser Settings When Working with XML Files on HTTP

Server

Web browsers may cache XML files posted on an HTTP server and referenced by
Oracle Smart View for Office. This can cause problems when using the following
Smart View functionality:

Accessing shared connections from an XML file

This is the XML file posted on an HTTP server and noted in the Shared
Connections URL field of the Smart View Options dialog box. If you plan to
access online help from a local drive or internal web server, this file can also
specify the location of the help.

Updating extensions

Smart View references the UpdateList.xml file that is posted on an HTTP server
when Smart View end users install, update, and remove extensions in the
Extensions tab of the Options dialog box.

Complete the steps in this topic to clear the browser cache so that the latest version of
the XML file is used for the purposes noted above.

To clear the cache so that Smart View is accessing the latest XML file version posted
on an HTTP server, set the following options in the Internet Properties dialog in the
Control Panel

1.
2.
3.

ORACLE

Launch the Control Panel, and then select Internet Options.
In the General tab, Browsing history group, select Settings.

In the Check for newer versions of stored pages section, select Every time |
visit the webpage, and then click OK.

In the Internet Options dialog box, select the Advanced tab.

In the Security section, select the Empty Temporary Internet Files folder when
browser is closed option.

Click OK to close Internet Options and restart the browser.
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Flickering Issues on Office 2013 and Office 2016

When using Oracle Smart View for Office with Microsoft Office 2013 or 2016, 32-bit or 64-bit,
flickering occurs with the POV toolbar and the Smart View Panel. The flickering is likely
caused by changes in Excel 2013 and Excel 2016.

To reduce flickering, use the Health Check utility in Smart View to specify the settings for
"Disable Window Transitions on Addin Task Panes" and "Disable Animations," listed under
"Graphics Settings." Oracle advises using the recommended settings for these options. See
Performing a Health Check On Your System for more information.

Smart View HTTP Session Timeout

ORACLE

HTTP session timeouts can occur, for example, when working with large queries that take a
long time to run, or when you're experiencing slower internet connections.

Other errors you may see in an HTTP session timeout include:

* An"Invalid pointer" error
e "XML Load Error: XML Document must have a top level element”

To avoid HTTP session timeouts, you may add the following Windows Registry DWORDS to
the Internet Settings key:

* Key Name:

HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Internet
Settings
e Key Values:
— DWORD: ReceiveTimeout
Value data: value in milliseconds
— DWORD: KeepAliveTimeout
Value data: value in milliseconds
— DWORD: ServerInfoTimeout
Value data: value in milliseconds

For example, 900000 milliseconds is the equivalent of 15 minutes. Adjust the timing
according to your requirements.

As a guideline, 900000 milliseconds is the equivalent of 15 minutes.
To add the timeout key values to the Internet Settings registry key:

1. Ensure that all Office applications, including Outlook, are closed.
2. Launch the Windows Registry Editor.

3. Locate and then select the following registry subkey:

HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Internet
Settings
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4. Add the three DWORD key values, ReceiveTimeout, KeepAliveTimeout, and
ServerInfoTimeout:

a. From the Edit menu, select New, and then select DWORD Value.
b. Type the DWORD name, and then press Enter.

c. Inthe Details pane, right-click DWORD you added in step 4.b, and then select
Modify.

d. Inthe Value data text box, type the timeout value in milliseconds, select
Decimal, and then click OK.

e. Repeat step 4.a through step 4.d for each of the three required DWORD key
values.

5. Exit Registry Editor.

6. Restart Excel.

Third-Party Monitoring Tools May Impact Smart View
Stability

Some of the applications monitoring Microsoft Office, such as MacAfee or Trellix, may
interfere with Oracle Smart View for Office. Smart View makes many Office and
Windows API calls, which may be detected, blocked, or delayed by these applications,
causing stability issues for Office and Smart View. Some users may experience Excel
failing when Smart View add-in is enabled.

Workaround: Administrators may review other applications running on the machine
and adjust the appropriate settings.

For example, for MacAfee, deselect the "Enable deep inspection of Windows API calls
EDR policy for affected hosts."

Refer to the documentation for your monitoring tools for information on disabling this
option.

Duplicate Queries in Word Slow to Refresh

In some Word documents containing a large number of queries and created prior to
Oracle Smart View for Office release 11.1.2.5.520, performance may be an issue when
refreshing the data in the document. In some cases, instead of re-using existing
gueries where appropriate, each Smart View data point in the Word document is
treated as a separate query. The result is that Refresh operations can be very slow.

If the document contains many duplicate queries (that is, queries with the same
name), the duplicate queries are displayed in the Document Contents pane in Word.
For example, Document Contents might look like this:
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Smart Yiew v )
Document Contents & ~-¥ »
[ Smart Yiew - Current Documment | vl -+ -

¥ SmartView14446361770
i 1,-0 SmartView14446361770
I a]"‘ SmartView14446361770
4% SmartView14446361770
b ﬂl\' SmartView 14446361770
A% SmartView14446361770
¥ Smartiiew! 4446361770
----- 2% SmartView 14446361770
¥ SmartView14446361770
o ® SmartView14446361770
¥ SmartView14446361770
m¥ SmartView14446361770
ol SmartViewl 4446361770
A SmartView14446361770
o SMnartiiew 14446361770
- a¥ SmartView14446361770
i 319 SmartView 14446361770
. ﬂl\' SmartView 14446361770
- 4® SmartView14446361770
¥ Smartiiew! 4446361770
ol Smartyiew 14446361770
S SmartView! 4446361770
- 4 Function Grid

m? SmartViewl 4446541490
m¥ SmartView]1 4446541490
P Omartiewl 4446541490
A SmartView14446541490
o SMnartiiewl 4446541490
¥ Smartyiew14446541490
i ﬂv SmartView 14446541490
ol SmartView14446541490
- a® SmartVievi14446541490
¥ Smartiiew! 4446541490
al® SmartView14446541490
¥ SmartView14446541490
o SmartView14446541490
¥ SmartView14446541490

i

The duplicate queries are SmartViewl4446361770 and SmartViewl14446541490.

You can run the Visual Basic macro below to remove the duplicate queries:

Sub DeleteExtraQueries ()

' DeleteExtraQueries Macro

Dim queriesName As Variant

Dim uniqueQueriesName As New Collection
Dim varName, newlList As String

ORACLE"
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Set vars = ActiveDocument.Variables

For i = 1 To vars.Count
varName = vars.Item(i).Name
If Not StrComp(vars.Item(i).Name, "SV _QUERY LIST", vbTextCompare)
Then
List = vars.Item(i).Value
queriesName = Split(List, "<[>")

On Error Resume Next

For Each queryName In queriesName
uniqueQueriesName.Add queryName, queryName

Next

newList = ""

For Each queryName In uniqueQueriesName
newlList = newlList & queryName & "<[>"

Next

newList = Left (newList, Len(newList) - 3)

vars.Item(i).Value = newList

End If

Next

End Sub

After running the macro, the two queries, Smartviewl4446361770 and
SmartViewl4446541490, appear only once in Document Contents:

Smart Yiew - X
Document Contents N -¥v »
| Smart Yiew - Current Document |*| <+ =

030 Financial instruments - B - corrected.d

=] ¥ Smartiew 14446361770
F§ Function Grid

=) 2% Smarttiew14446541490
Fa Function Grid

Custom Styles and Merged Cells in Forms

ORACLE

Excel formatting and custom styles are intended for use with static grids. When the
grid contains merged cells, then changing the POV can result in invalid formatting.
Other operations that can result in invalid formatting are:

» Changes to Suppression options

* Enabling or clearing the Repeat Member Labels options
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* Adding members to the form definition

After any of these operations, if you encounter an error, such as "We can't do that to a
merged cell" or invalid formatting with your form layout, try the following steps:

1. Inthe Planning ribbon, Formatting group, click Clear.
2. In the Formatting group, click Save.

3. Open the form on a new sheet.

Fixing Function Links on Machines where Smart View was
Reinstalled in a User-specified Location

When connected to an Oracle Smart View for Office provider, such as Tax Reporting in EPM
Cloud or Essbase in EPM System, and using functions on a machine where Smart View was
reinstalled in a different location (for example, originally Smart View was installed in the
default installation location and then, on the same machine, Smart View was reinstalled in a
user-specified, non-default location), the functions may not work correctly after reinstalling
Smart View. To fix this issue, perform the following steps:

1. In Excel, go to File, then Options, then Add-ins, then Excel Add-ins, and click Go.

2. Inthe Add-ins dialog, select the check box for Hstbar. This gives an error message
stating that "the HsTbar.xla file is not found in the location. Do you want to delete it?"
Click Yes to delete it.

3. Close and relaunch Excel.
4. Open the saved workbook and connect to the data provider.
5. Inthe Smart View ribbon, go to Functions, and then Fix Links.

Fix Links updates the function definitions.

Session Timeout when Connected Using Vanity URLS

You may experience a timeout error when trying to connect in Smart View using a vanity
URL. This issue is vendor-specific, as the timeout is occurring on the vanity URL provider.
The vendor is delivering the error message in this case.

Memory Error on Large Queries

Data source types: Oracle Essbase, Oracle Essbase

When running large MDX queries against an aggregate storage database, you may run in to
the following "out of server memory" error:
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rErrc-r @1

Error processing request, Please check log for details,
Essbase Error (1200766): The number of query result cells exceeds the limit
[1000000] set by the QUERYRESULTLIMIT configuration setting

b 0K

L

To resolve this issue, raise the limit in QUERYRESULTLIMIT in essbase.cfg. See
QUERYRESULTLIMIT in the Technical Reference for Oracle Analytics Cloud -
Essbase for instructions on this configuration setting.

" Note:

The information in QUERYRESULTLIMIT applies to both Essbase and these
Essbase versions: 11.1.2.4.008, 11.1.2.4.505, and 11.1.2.3.508_22314799.

Issues with Dynamic Data Exchange Option in Excel

Various issues may arise when the Excel option, Ignore other applications that use
Dynamic Data Exchange (DDE), is selected. For example, there are problems
launching Excel, launching Excel files from outside of Excel, and using the Export in
Query Ready Mode option from a browser to export balances from Oracle Hyperion
Financial Reporting.

Workaround: Click the Microsoft Office Button (upper left corner of Excel), and then
click Excel Options. In the Advanced category, scroll down to the General options,
and then clear the Ignore other applications that use Dynamic Data Exchance
(DDE) check box. Restart Excel.

Performance and Memory Usage Considerations for Smart
View with Excel

Oracle Smart View for Office is a Microsoft Office add-in. As an add-in, it is loaded in
to the Microsoft Excel process. When a report is imported into Excel through Smart
View, the Excel process consumes memory and this can negatively impact
performance.

For example, instances of grids and forms, objects in the Undo buffer, XML parsing,
etc., will cause the Excel process to consume memory. Because of this, the Excel or
machine memory limit becomes the Smart View memory limit as well. This can
severely impact performance.

There is no memory configuration parameter in Smart View to manage this.
Excel 32-bit and 64-bit have different memory limits:

*  For Excel 32-bit, the maximum memory limit, or RAM, is 2GB.
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Oracle testing showed that when Excel 32-bit memory usage reaches beyond 700 MB,
Excel can behave abnormally and can terminate unexpectedly.

The 64-bit versions of Excel are not constrained to 2 GB of RAM, as are the 32-bit Office
applications.

For large reports, Oracle recommends using 64-bit Excel. Or consider reducing the data
being sent to Smart View by reducing the number of rows, columns, and POVs in the
reports.

Oracle suggests that you consider taking some or all of the actions listed below in an effort to
limit memory usage and improve performance.

The following actions can help to limit memory usage:

1.

In the Smart View Options dialog box, Advanced tab, ensure that these options are
enabled:

* Reduce Excel File Size
* Improve Metadata Options

In the Options dialog box, Advanced tab, set Number of Undo Actions to '0' (zero), if
possible, or to a low number such as 1 or 2.

Change Excel calculation from Automatic to Manual. Go to the Excel Formulas ribbon,
then select Calculation Options, and then select Manual.

In the Options dialog box, Formatting tab,

a. If you have selected the Use Excel Formatting option, then you should clear the
Move Formatting on Operations option.

b. Clear the Adjust Column Width option.
c. Clear the Retain Numeric Formatting option.
In the Options dialog box, Extensions tab, disable any unneeded extensions.

In Excel, to improve performance and stability, disable or uninstall any unused add-ins.
For example, disable or uninstall the Oracle Essbase Spreadsheet Add-in. Other possible
add-ins to disable or uninstall are, for example, Adobe PDF, WebEXx, or Send to Bluetooth

Reduce the workbook size.
Limit the data imported to Excel:

a. Use prompts, filters, POVs, or other ways to reduce the data returned back to Smart
View.

b. Enable the Suppress Rows and Suppress Columns options in the Data Options
tab of the Smart View Options dialog box.

The following actions can help to improve performance, as well as limit memory usage:

1.

In the Options dialog box, Advanced tab, set Number of Undo Actions to '0' (zero), if
possible.

In the Options dialog box, Member Options tab, ensure that these options are cleared:
* Preserve Formulas and Comments in ad hoc options
*  Formula Fill

Clear these options only if you do not need to preserve formulas or comments during ad
hoc operations.
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Also, refer to the following documentation from Microsoft, "Excel 2010 Performance:
Performance and Limit Improvements":

http://msdn.microsoft.com/en-us/library/ff700514(v=office.14).aspx

Unbalanced Loads in Provider Services Clustered
Environments

In some Oracle Hyperion Provider Services clustered environments, if Oracle Smart
View for Office requests appear to be going to only one server in the cluster (that is,
the load is unbalanced), then try changing the Internet Properties security level to
Medium.

To do this, in the Control Panel, select Internet Options, and then select the Security
tab. Under Security levels for this zone, set the allowed level for the affected zone to
Medium.

Two-Way SSL and Problematic Certificates

ORACLE

If two-way SSL is set up with problematic certificates between Oracle Smart View for
Office and other Oracle Enterprise Performance Management System data providers,
Smart View will prompt for the client-side certificate with every request. For example,
the user will be prompted when connecting to the data source, connecting to an
application, connecting to a database, and at every refresh, submit, or zoom operation.

To avoid this situation, you must update the properties.xml file on each end user
machine to add the clientCert name tag. For example:

<cfg>
<provider>
<url>http://server:port/workspace/SmartViewProviders</url>
</provider>
<helpurlcontext></helpurlcontext>
<extensionupdatelist>http://server:port/extensionupdatelist/
UpdateList.xml|%$SVCLIENTINSTALLPATH%/extensions/UpdateList.xml</
extensionupdatelist>
<!-- Require Smart View to prompt the user for the client-side
certificate -->
<clientCert name="PROMPT-ONLY"/>
</cfg>
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